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Introduction

Thank you for choosing ProtaSteel — Steel detailing & connection creation module of the ProtaStructure
suite. The primary steel model must be created in ProtaStructure. The model can be exported & opened
in ProtaSteel seamlessly. In ProtaSteel, you can :

e Model ancillary/secondary steel members such as roof purlins, girts, sag rods, staircase, etc.
e Adjust members to final positions for accurate detailing
e Create and design steel connections

e Create any steel connections manually, save them macro library and reuse them at similar
nodes.

e Produce engineering drawings of the steel structure and connections

e Sharing the 3D model created with other BIM platforms such as Tekla Structures.

Before you proceed, it is highly recommended you go through ProtaStructure User Guide as knowledge
of the fundamentals of ProtaStructure is required.

This Quick Start Guide aims to get you up and running quickly. You should be able to learn the
fundamentals of ProtaSteel in approximately 2 hours by following this simple guide.

Exporting Model to ProtaSteel

A sample steel model is already created & installed in the default installation folder of ProtaStructure.
We will now open the model, run analysis & export it to ProtaSteel :

e Start ProtaStructure and the Open Project dialog will appear.
e Select & open project “Quick_Start Steel_Complete”

e Go to Analysis = Building Analysis

e Go to Analysis tab = Tick Building Analysis = Start

e Close the Building Analysis menu

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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e Goto Drawings & Reports = Load ProtaSteel
ProtaSteel will start and load the project model. ProtaSteel model is created in the subfolder

“ProtaSteel” in the project folder.

User Interface

The various components of the ProtaSteel user interface are as shown below:

Quick Access Toolbars 3D View - ProtaSteel 2022 - CA..\Quick Start_Guide_Steel Complete.px2 Model/Project Title

ile )i e Drawi ) Hels - 8 X
[Fle  Steel imeliComect Edit View Drawings&Repons Toos M Hep |¢— Toolbars Tab
HX QX | 2 o2 < [25a) _ o
o= Ay L OB —2 y/ i\ & A {l = =] E' e J \'s) \ ———————————————
. A ~
i Pain G Jow Sume | M Seciow Gemer for Wed twes nows  Deming | > Ribbon / commands |
& B e Plate - Beam fishmouth Item Manager I
Visibility = Steel Elements Detailing 7 ~

oo ind *| B Visibility Filter . s it i
Tyl view: > I ISy > Recent

; > Beam to Beam Connections

> Beam to Column Connections

> Bracing Connections.

> Splice Connections

> purlin & Girt Connections

Model View >

> Base Plate Connections

> Truss Connections
> Detailing

> Ancillary Steelwork

> Miscellaneous Steel Detailing

> User Defined

Macro Galle

Selectibility
Filter i
l L i

= — _ StatusBar

Model Explorer

Default views are created under the “Views” folder in the model explorer pane. By default, the views
created are the 3D views & plan views of each story.

Double-click on the desired view in the left-hand Explorer pane to open it. You can open as many
views as you like.

The graphical editor supports multiple windows; you can open as many windows as you desire.
Modeling can be done both on the plan view and the 3D view.

Steel Elements and Detailing

X QXL | g2 oD P

ey & = Q"t w M dih & - h s}
']

L Purlin ~ Girt  Joist  Stringer Plate Sectional Chamfer Bolt Weld Eaves Embed Detailing Item

LS E e Plate - Beam  Fishmouth Manager

Visibility = Steel Elements Detailing

“Visibility” filters are very frequently used commands and are fixed in the top left corners of all menus
in the top menu. By using visibility filters, elements that are not wanted to appear on the model can be
removed from view.

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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In ProtaSteel, you can only create joist, purlin, girt, sag rod, and stair member (stringer). Primary
members such as beam, column & brace must be inserted in ProtaStructure.

Stair members can create both ProtaSteel and ProtaStructure. But, in the Protasteel, loads can not
assign to the stair beams and can not design the sections.

Detailing tools include the manual connection members such as plate, sectional plate, chamfer, bolt,
weld, connection detailing item manager, etc.

Intelliconnect Tools

File Steel IntelliConnect  Edit View Drawings & Reports Tools BIM Help

Hxol SgX O N\ LUK s E B
@ T 4w LA~ S =
Purins Girts Sag  Batten Stringer Splice Base Bracings Trusses Floor  Column/Beam Node  Clesr

t 2 e Rods Plates  Holes  Connections Plates Besmm:  Connections Control  Nods
Visbilty IntelliConnect Wizards IntelliConnect Tools

&

Intelliconnect is an intelligent connection tool that can be applied for different element types. In this
menu, quick access to commands separated according to the member type can be provided. These
commands can also be accessed from the right-click menu.

More detailed information about IntelliConnect can be found later in the document.

“IntelliConnect Tools” are used to clean the information on nodes previously connected by
IntelliConnect. For example, you have modeled connections with IntelliConnect on truss elements. But
you changed your mind and deleted these macros. Afterward, you should also apply “Clear Node” at
these points. Otherwise, you cannot model connected with IntelliConnect again.

Edit
File Steel IntelliConnect Edit View Drawings & Reports Tools BIM Help

FXIX Eﬁ :D i/ s Eu !D E o m +— Construction Object ~ k? % |@ B Show Only Selected V/ ab Iy 28

@ T 4w ) ; X Point - =" [ Show Selected Z L o

L e Copy Move Mirror Rotate Polygon Object Boundary Measure  New Selection Select Show Materials  Profile Edit Match
[ - - G

Visibility Copy & Move 5 Cut Operations Reference Objects Selection Misc.

ut Cut Cut - Grid = Dimension N Fitter = M Al B Hide Selected Annotation  Frame~  Elements

Copy, move, mirror, rotate, cutting objects located in this menu. These commands are also available in
the right-click menu.

We can use reference objects such as points, lines, circles while detailing in ProtaSteel. These commands
are only used during modeling in the interface, and they are not transferred to the drawings.

With selection modes, desired elements can be displayed or removed from view in ProtaSteel.

Many parameters such as profile sections, materials, macro types, or element section types can be
filtered with the selection filters. At the same time, any assembly or part number in the model can be
found quickly with the help of filtering.

Divide and join commands can be applied only to added elements in ProtaSteel.

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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View

File Steel IntelliConnect Edit View Drawings & Reports Tools BIM Help

Plane View - ) By Three Point: Expl
X @I | () Plane View [ Object Draw Mode -~ @) E? I I @ % SoyheeranE L A Dol Explorer

@ L 4w ) (% View by 3 Pts & To View Plane = =M Macros
w IS @ Projection Mode - | Visibility  View Color Zoom View More Maximum  Messages
} i [ . View < View by 2 Pts = Filter = Coding ™ @ List = =+ To Global Options ~ Medel View [ Use Tebs

Visibility ] Model View ] Set Workplane User Interface

In the ProtaSteel interface, we can create a two-dimensional cross-section by showing the two or three
points we want on the model.

We can use “with 3 points” to create a plane on the roof. We often use “with 2 points”, especially when
making manual connections.

We can set the drawing mode and perspective view of the objects from this menu.

With the color coding tools, we can show the connection status, material sections, or materials with the
color.

Zoom and Pan Methods

The view manipulation is similar to ProtaStructure. You will find it easiest to use the mouse wheel to:

Zoom in — scroll your mouse wheel up

Zoom out — scroll mouse wheel down

Pan (move) —hold down the middle mouse wheel and drag
Rotate — Right-click & drag

The following keyboard shortcut keys are helpful:
Zoom All —Home key = Zoom so that all content is visible in the viewport

Origin of Interest —F9 key - Set the center of rotation by clicking on any node or object (such as
bolt or plate). The model will then rotate around the selected point.

Selection Methods

Click on an entity to select it.

Hold down the CTRL key and click on the macro to access macro properties.
To select multiple entities, hold down the CTRL key while picking them.

You can drag with the mouse to access further selection options:

Drag from left to right to create a rectangular box. When you release the mouse button, all entities
wholly contained within the box will be selected

Drawing a box from right to left will select all entities within the box and cross its boundaries.

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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To deselect all entities, click on a space anywhere in the viewport.

Set Workplane

The working plane is essential for using some commands and for the movement of objects, such as
copying and moving in the direction we want. By adjusting the working plane to any plane, location,
point, or surface we want, we can provide object movement in that plane.

The working plane is indicated in the interface by red and green arrows.

By 3 Points — Creates a new workplane by selecting 3 points

To View Plane — Moves the workplane to the active view plane

To Global — Moves the workplane to the global plane

To Object — Moves the workplane to the local coordinate plane of a point
To Surface — Moves the workplane to the surface of an object

To Point — Moves the workplane to a point

Rotate and Move — Rotate and move the work plane

User Interface

The model can be displayed as a full screen in the interface. The side menus with the “Model Explorer”
and “Macro Gallery” can be closed and opened. All views created by clicking the “Maximum Model
View” button can be viewed and closed collectively.

Drawings and Reports

File Steel IntelliCennect Edit View Drawings & Reports ~ Tools BIM Help
FX DL -1 55 -7 = = == L
L = £ ¢ 7 B |2 |@ @
= I Drawings Perform Drawing Create Open Part  Open Assembly Material Show Design Create
} w A e Numbering ~  Settings = Drawings = Drawing Drawing Takeoff ~ Report  Summary -
Visibility [l Drawings Material Lists Connection Design Checks
Drawings

“Drawing Module” is opened with the “drawings” command on the top menu or double click on the
“Model Explorer > Drawings”. Also, the CTRL+D shortcut can use to open it.

Numbering

ProtaSteel performs the numbering process according to the similarities of all assemblies and parts in
the model whose detailing has been completed and whose drawings will be prepared.

Drawings cannot be created without numbering on models with finished detailing. The issue of
numbering is explained in detail in the following sections.

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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Material Lists

Protasteel can prepare material lists for all members or selected members on the structural model. In
addition to the assembly and part lists, sub-part lists that make up each assembly are also prepared.

The lists are prepared in detail according to the features such as thickness, length, surface area, section
type, number of bolts, material quality.

Connection Design Checks

The structural model, whose analysis is completed in ProtaStructure, is transferred to ProtaSteel with
internal forces. ProtaSteel uses these internal forces in connection designs. The design code can be
selected from the “Project Preferences” section in the “File” menu.

Calculation reports of a connection can be accessed via the connection’s context menu. The summary
table for all connections can be accessed with the “Design Summary” command. Design reports for
different design codes of the same connection can also be created.

More detailed information on this issue is given in the following sections.

File Steel IntelliConnect Edit View Drawings & Reports Tools EIM Help
g g 4 #x«W®
Profile Bolt More Clash  Audit Macro
Database Database Tools ™ Check  Model Defaults
Database Diagnostic Tools
Database

Profile sections used in the building model are defined in ProtaStructure and transferred to ProtaSteel.
Additionally, the profile catalog in ProtaSteel can be used for sections such as purlin, girdle, beam to be
defined in ProtaSteel.

If you cannot find the profile in the ProtaSteel profile catalog, you can use it by defining the desired
section type in the database. The same method can use for bolt catalog.

Diagnostic Tools

After the connection detailing processes are completed in ProtaSteel, clash checks should be done
before drawings are prepared. If there are collision problems between the members, the model should
be reviewed.

Detailed information on this issue is explained in the following sections.

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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BIM

File Steel IntelliConnect Edit View Drawings & Reports Tools BIM Help

W © @ O e

Import  Import from Export  Export Export
DXF ProtaStructure IFCFile NCFiles  to TEKLA

BIM Links

Import DXF

Plans and sections in architectural projects can be exported to ProtaSteel with DXF 2000 file. In
particular, this feature allows the control of the architectural project and the manufacturing project by
superposing.

Import from ProtaStructure

As known, ProtaStructure exports the structural model to ProtaSteel. Similarly, data can also be
imported from ProtaStructure into a ProtaSteel file.

Export IFC File

The structural model prepared in ProtaSteel can save as an.IFC file. So, the structural 3D model can also
open in the other software.

Export NC Files

CNC machines are generally used to create structural parts. Parts create the assemblies. ProtaSteel
produces “.NC” files and quickly transfers the part drawings to CNC machines.

Export to TEKLA

The structural model prepared in ProtaSteel with all its details can be transferred to Tekla Structures
software.

The transfer process is done with a plug-in called TEKLA 10. This plug-in is located on the “Downloads”
page of the ProtaStructure website. (https://www.protayazilim.com/downloads).

You can watch the video about using the plug-in on the ProtaStructure Youtube channel.

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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File Steel IntelliConnect Edit View Drawings & Reports Tools Bir Help
%

ProtaSteel  Basic Training  Shortcuts About
Help Guide

Help

ProtaSteel Help

When guides and reference manuals are needed, users can always click on this option to directly lead
them to our Prota Help Center.

Basic Training Guide

Basic Training Guide can be very helpful before starting a project or when working on a project. The
training guide can always be referred using this link.

Shortcuts

Shortcut keys which can be handy when dealing with repetitive commands. A list of shortcut hotkeys
can be found in this link.

About

The company license information and ProtaSteel version and module can be found here. Other than
that, Protasoftware support contact (e.g. email) can be found here.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Automatic Connection Tools (Macro Gallery)

The macro gallery is located in the right side menu in
ProtaSteel.

Macro Gallery L =

» Recent

“ Beam to Beam Connections

Macros are smart connection tools that allow us to
model steel connections quickly—for example, fin plate,
gusset plate, haunch connection, splice, etc.

. . Beam to Beam End  Stiffened End Plate Fin Flate
All macro types are classified according to the member Plate
types they are connecting. ”
Recent macros can be selected quickly at the top of the
macro ga”ery Beam to Beam Angle  Fitting Connection Apex Haunch

Cleat

The manual macro command is also at the bottom of the
list. The user-defined macro library can be created here.

Beam to Beam Fixed

Detailed information about macros is given in the Connection

following sections

» Beam to Column Connections
» Bracing Connections

» Splice Connections

» Purlin & Girt Connections

» Base Plate Connections

» Truss Connections

If you hover the mouse cursor over any icons, a tooltip

» Detailing
will appear with a detailed explanation of how to use it. > Ancillary Steehwork
You can set the default parameters for each run by right- > Miscellaneous Steel Detailing

A 5 A » User Defined
clicking on the macro icon.

Macros

e A macro is generally defined as a shortcut tool that specifies how a particular input sequence
will result in the desired output according to a defined procedure.

o Before creating the macro elements, you can set the macro settings, e.g., member profile, plate
offsets, bolts, etc., by right-clicking on the macro icon, which will bring up the Macro dialog.

e Once a macro is clicked, the mouse cursor will change to the hand icon @ implying that it is
waiting for object(s) selection. A crosshair + icon means that it is waiting for point selection. The
tooltip states that perform the required action(s) to get the desired result.

e The macro will remain activated; you can continue using the macro without clicking on the
macro icon again.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"



2 rRoTA page 15

e Once you have finished, you must press ESC to cancel & stop the macro. The mouse cursor will
change back to default arrow h (selection mode).

e After creating the elements in a group, such as the purlins, each element will have its individual
properties, which can be changed by double-clicking on it = this will bring up the Element
dialog.

e However, all the elements are still associated with the macro & can be changed in a group.

e This can be done by selecting the macro sign s & then pressing ENTER will bring up the macro
dialog. After making the changes, clicking Apply will apply to all the elements associated with
the macro. Clicking Get will set it to default for this macro for future projects.

e Suppose you have problems selecting the macro sign. In that case, you can choose any element
or component of the macro (e.g., a plate of a connection) then press “M” = this will select the

macro = hitting the ENTER key will expose the Macro dialog.

e You can select all the elements associated with the macro by selecting the macro sign or an
element of the macro = press “CTRL + M”.

e You can also delete all the elements & components of a macro by selecting the macro sign &
then hitting DELETE.

e |tis highly recommended you review the macro settings before executing them.

e You can reload/clear the changes in the macro default setting by going to Tools (tab) 2 Macro
Defaults = Select macro = Reload/Clear Selected Macro Defaults

Macro Defaults 4
Filter

2D Fitting Macro A
3D Fitting Macra

Anchar Bar

Anchar Balt

Apew Haunch Connection Macro
Apex Tuss Gusset Connection Macro
B aze Plate Connection b acra without Design
Batten Plate Connection Macro
Beam Gusset Splice Macio
Bream to Beam Angle Cleat Connection Macro
Eeam to Beam End Plate Connection Macro
Bieam to Beam Fired Connection Macra
Ezam to Column End Plate Connection Macro
Eieamn to ' all Cannection Macro

Ik
Copy Manager Macro
Corner Balted Gusset Plate Connection Macro
Corner Stiffener Macio
Cormer Welded Gusset Plate Connection Macro
Drirect welding Connection Macio
Eaves Beam Cornection M acro
Eaves Beam Macro
Embedded Steel Macro

End Plate Detall Connection Maca

End Flate Splice Macrno

Extended End Plate Connection Macro
Fin Plate Connection Macro

Fitting Connection Macro

Flange Plate Moment Connection Macro
Floor Macro

Folded Plate

Hand Rail Maco

HandR ail Connection Macro

Haunch Cornection Macro

Hollow Section Base Plate Cornection Macro hd

Reload Selected [1) Macro Defaults

Clear Selected [1)] Macra Defaults Cloze

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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Selecting the Macro Associated with Objects
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You can click the Macro icon = on the screen to select the macro associated with any object.
However, as the number of objects in the model increases, it may become challenging to distinguish

macro symbols. To quickly select the macro associated with any object:

e Select the object. (For example, a plate, a bolt group, or a weld)

Press M on the keyboard. The macro symbol will be selected.

DELETE key to delete/remove the macro or associated objects.

Selecting All Objects Associated with a Macro

In some cases, you may want all objects related to a macro to be selected. For this:

e Select the macro symbol.

e Or select an object created with macro.

e Press CTRL+M on the keyboard to select the associated entities.

Views and View Settings

Press ENTER on the keyboard. So, you can open the macro properties window. Press the

The 3-D view is created by default and displayed on the screen when you open the | Medelbwlorer = %
. . . V-E Views
project. However, plan views at each floor level are also automatically generated. & 3 view
|| (Storey T)
E (sm;:: 1)
Views are displayed under the “Views’ folder in the left project panel. ey
~[@] Grid 4
iGrldB
e Double-click on the desired view in the left project panel will open that is b
view. You can open as many views as you want. = Pt
-[@] Grid A
~[@] Grid €
[&] Grid 1
-[@] Grid 2
V-gﬁ Grids
i beeff Di0ie
Drawings (Ctrl+D)
You can open the View Manager by double-clicking the —
ew Eﬂﬂg&l’ x
Views heading in the build tree. Closed isws Open Views
[Storey T) == | 3D View
[Storey 1)
i . * Gy
In the view manager: Girid 3
Grid B
Roof Graup 1
. Flaof Group 2
e View canopen Floof Group 3
) E::il;ffluupﬂi
e View can close Gd
Il
e View can delete fria 2
° YOU can Cha nge the V|eW propertles Cancel Wiew Properties Delete Yiew
ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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If the multiple views open, you can fit them to the screen by using the Views > View list> Tile Horizontal
/ Tile Vertical / Cascade.

File Steel IntelliConnect Edit. View Drawings & Reports Tools BIM Help
HXQOI () Plane View - ox s By Three Points [ Explorer
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You can change the object draw mode using “View > Object Draw Mode.
File Steel IntelliConnect Edit View Drawings & Reports Tools BIM Help
H X @I | (T)Plane View ~ @ ? n @ % L, By Three Points
@ L 4w (% View by 3 Pts ) i L To View Plane —
= o @ solid Visibility  View  Color  Zoom  View More
+ 2 E e | view 3 Viewby2Pis B Contour solid - Fiter~ Coding~ ~  Listw | o ToGlobal Options ~
Visibility ] ] Set Workplane
@ Wireframe
Model Explorer ¥ x | N\, Line

You can cycle through the drawing modes by pressing the Alt + D key combination repeatedly

You can specify the 3D view is perspective or orthogonal by using Views > Projection Modes.

File Steel IntelliConnect Edit

ﬁ X Q T | @PlEHEViEW -
@ T 44w % View by 3 Pts
F W | view 5Viewby2Prs

F]

Visibility

| Medel Explorer £ X ‘

View

Object Draw Mode ~

{{IProjection Mode  ~

Drawings & Reports

@ Orthographic Projection
@ Perspective Projection

Tools BiM Help
Visibility  View Color Zoom  View
Filter = Coding ~ - List ~
F]

‘L, By Three Points

b To View Plane =
Mare
L To Global Options ~
Set Workplane
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Creating new Views

File Steel IntelliConnect Edit View Drawings & Reports Tools BIM Help

HXPI | ;l (T Plane View ~ ®Object Bl - @ E? I:I @ % ‘L, By Three Points L g [E Explorer
@ T o4 e (% View by 3 Pts L To View Plane e =B Macros
e 3D . Projection Mode - Visibility  View Color Zoom View More Maximum  Messages
b e B e || view |5 Viewby2Pts = - Fiter - Coding= -  List~ | b ToGlobal Options = Model View B Use Tabs
Visibility ] Model View Fl Set Workplane User Interface

In addition to the 3D view and plan views automatically created in ProtaSteel, a new 3D view can be
created with the Views > 3D View.

To create a quick view at a certain depth by specifying the X, Y, or Z directions of the 3D view, a view
can be created according to a particular plane with the Views > Plan View option.

For example, selecting “XY Plane View” opens a text box for entering a depth value in the plane direction.
Let’s write a depth value of 5000 mm in this text box. In this case, the resulting view is added to the
building tree by giving the name “5000 mm elevation plan”.

Create view in XY plane X

Enter the Z value below: 5000

Cancel

Section views can also be created from the desired region of the building model by selecting 2 points
and 3 points.

File Steel IntelliConnect Edit ~ View  Drawings & Reports  Tools BIM Help

X I |{F () Plane View ~ () Object Draw Mode - @ ri? I=I @ % L, By Three Points L A [E] Explorer
30

@ T 4w [ View by 3 Pts L ToViewPlane == =M Macros
e Projection Mode  ~ Visibility ~ View Color Zoom  View More Maximum  Messages

} i A - View | 15 View by 2 Pts 7 o Filter = Coding ™ 2 List & To Global Options ™ Model View {5 Use Tabs
Visibility =] Model View I Set Workplane User Interface

Let us create a new sectional view along grid 3 :
. IGVA . ” u View by 2 Pts
e GotoViews (tab) = select “View by 2 Points.”  +=*
o Click two points to define a plane = the view will be created as shown below

A white line arrow will appear once the mouse cursor hovers on 2™ point. This white line indicates the
direction of viewing. In this case, the above view is looking into the building.

The coordinate system will be changed according to the current work plane.
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The sectional view is created from the same 3D model but viewed from a different camera angle or
orientation. Changes made to the active view are automatically reflected in all other views. The extent,
boundary, and objects to display can be set via View Properties.

To access the View Properties:

Double-click anywhere on the new view = The View Properties will appear.

View Properties

View Name

R

/1
| Save

Up (4 [ 1000

Down {-)

[-1000

I
N
R
R

Select

Minirnurm X
Maximum X
Minimum

Maximum Y

Reset

Rotation
Angle Around X

Angle Around Y

Angle Around Z

[o

| Filter

[o

| Drawing Settings

[o

~' | Draw Coordinate System

Projection
(® Ortho

O Perspective

Filter Point Mode
(0) 2D Last Positions

(®) 2D Definition Positions

(C) 3D Positions

Clipping
() Enabled
(®) Disabled

Filter Grid Mode
() Unlimited Up/Down

() Pass Always

Apply

(@) Normal Cancel

Give the view a new name, “Axis A.”

Change the Up(+) and Down (-) to 1000mm and -1000mm respectively.

This means that the view will only show elements 1m into & out of the plane. This will make the

view less cluttered as elements along other grids will be hidden. If zero values are entered, then

it will be unlimited.

Up-Down Method :

- Partial: Any element that exists partially within the set extents will be shown

- Full: Only elements that exist entirely within the set extents will be shown

ProtaStructure’

ProtaSteel’

ProtaDetails’

ProtaBIM"




2 rRoTA Page 20

e C(lick OK to close the dialog & the view will be updated.
Any sectional view is inherently a 3D view. Hence you can still rotate the view.

e Right-click and drag to rotate the Axis 3 view. (Notice that only members within the 1 m extent
are shown.)

e (o to View Properties again.

e Change the Up-Down method in View properties to FULL = Apply (Notice all the beams out of
the plane of Axis A will be hidden.)

e Press F4 to restore lookup (i.e., convert to original viewing direction)

You must give the view a new name and check/tick “Save” to ensure the view is saved. Only saved views
can be used to generate drawings in the drawing module.

Automatic View Creation

ProtaSteel can automatically create a 2D section and plan views from all structure axes.

[ ] Select “Grids” § e Model Explorer R X
i SetView Properties
?a Inquire v | ﬂews
. . B% SaveBitmapto Clipboard | | || i [ 3D View
hd RIght_Clle- Select Origin of Interest ~ F9 (Storey T)
5 (Storey 1)
[ Show Selected (Storey 2)
. . Hide Selected )
e Select “Grids > Create VIEWS & g onyseieces &3
on Grid.” e Grid B
= Measure Distance Alt+R Roof Group 1
Measure Angle Roof Group 2
Copy Roof Group 3
Copy Special » Roof Group 4
Move Grid A
Section and plan views are created Wittt ; Grid C
Match Elements Grid 1
automatically from all grid and floor B = Sl
. Set Work Plane » UTEW on |?I'1E A
levels. The ProtaSteel automatically N———— , View on ne D
iew on line B
labels all sections. Draw Type » View on line E
| ) Selection » Wiew on line C
T Viewaniie 1

View on line 2

View on line 3

View on line 4

Plan at elev, 0 mm

Plan at elev. 5000 mm
. Plan at elev. 8000 mm

layout drawings. T

= D:1016

Drawings (Ctrl+D)

Delete Created Views ‘

Thus, you can effortlessly create all sections to be added to the general

With the “Grids > Delete Created Views” command, you can delete the
created views in bulk.
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Visibility & Selectability
You can control what objects are visible and selectable by assessing the Drawing Settings dialog:
e Double click on the view and pick Drawing Settings in the View Properties dialog
e Alternatively, click on the Visibility icon in the View tab
e Turn off the Grids & Points
e Apply and see the effect
e Go back and turn them on

You can Save As these different settings as another name to quickly reuse them.

View Properties X Visibility and Selactability Settings x
Rotation
View Name mgenewdx o] File
Wisibilit ~ || Save Save b Delete
Aome moemondy o] o g
- angemoundz 0] Selectatilly || save | saveas | Delete
Ezm(® [ BeasEoainalSialeny Wisibilty & Selectabilty
Wemmx [0 || rolecton clpaing N N
@ ortho OEnabled Visibility Selectability Visibility Selectabili
e —
O perspective (@ Disabled FGirids v v Plates v v
R .
Poirts v v Balts W v
Maxi Filter Paint Made Filter Grid Mode
ol ]
(0 2D Last Positions (O Unlimited Up/Down Jaints v v Bolt Holes v
Reset select @ 2D Definition Positons () Pass Always Apply Frofiles v v Welds v v
Up-Down Method | Partial || (3D Positions (® Normal Cancel Release Symbaols v Reinforcement Bars | v
Prafile Points v D=<F Solids v v
Macro Symboks v v
Cuts v v
Solids v v
Construction Lines v v
Clipping Planes v v Chamfer Effects Vv
Dimensions v v Auto Snap v
Anhotatiore: v v Free Paints
5 ][ | coa

“Visibility” shortcut buttons are also available in the “View” ribbon tab.

Steel IntelliConnect Edit View Drawings & Reports Tools BIM Help

H X DX | (7] Plane View - R Object Draw Mode ~ | (@) E? I=I @ % Ly By Three Points Pz A [E Explorer

@ F 4w ' (% View by 3 Pts b To View Plane M Macros
— . Projection Mode - | Visibility  View Color Zoom View More Maximum  Messages
Lo B | view D Viewby2Pts = - Fiter© Coding~ ~  List~ | o0 ToGlobal Options ~ Model View [ use Tabs
[F] Maodel View Fl Set Workplane User Interface

“Selectability” shortcuts are located at the bottom left of the screen in the interface.

| || % @ 0° o ™ 1.9 T OO = gt
HAX QL@ E 4wk w|e Vit | v (&l OIX|Al2l 2] T [ » &
0 obj. Mormal

<

Select a preset
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Adjustment of Members by Creating Points

In ProtaSteel, you might also want to adjust the position of members that are not precisely at the correct
position, i.e., fine-tuning of final member positions for detailing purposes.

In ProtaStructure, all the braces inserted will join at the top of beams instead of at the middle (centroid)
of the beam. This is because the analytical position of any beam in elevation is at the top of the beam.

The following example is provided for educational purposes. In the models defined in ProtaStructure,
truss members such as top chord, bottom chord, diagonal and vertical members, purlins, and braces
are defined in their correct positions and transferred to ProtaSteel ready for detailing.

In ProtaSteel, detailed tools are available to adjust the positions and fine-tune the members that are
not in the correct position. Follow these steps :

e Double-click on the previously created Axis 3 view in the Model Explorer

e Zoom in to the location of the diagonal braces between Grid Cand D

As you can see, the diagonal bracings are
connected to the top of the beam. It is more
accurate for the bracings to join at the middle of
the beam.

To do that, we must create a point (or node) in the
middle of the beam.

With the point created, we can then move the
ends of the bracing to this point.

Note: Alt + D key combination can switch drawing
modes.

File Steel IntelliConnect Edit View Drawings & Reports Tools BIM Help

RTINS Y

ew

:£ HCMMMHOMM: k? 235 @ [B) show Only Selected ﬁE If

X Point (@) Show Selected

= Copy Move Mirror Rotate Polygon Object Boundary Measure i Selection Select Show Materials  Profile Edit
t @ e - - Cut Cut Cut - Grid = Dimension M Filter ~ - Al [E)Hide Selected Annotation | Frame *
Visibility Copy & Move i Cut Operations Reference Objects Selection Misc.

The “Adjust Frame Manually” command is located in the “Edit” menu. I,

Edit
Frame ~

Break Frame
Join Frames

Resize Continuous Frames

Beii e &<l

End Point Operations

+/' Select Start Point(s)
A Select End Point(s)

%" Swap End Points

I #»  Adjust Frame Manually ]
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e Press Alt + D until you see the outline
of members only (wireframe mode)

*

e Click “Create Dividing Points” icon ~

in Edit (tab)=> Point
e 1 —Click top point of the beam

e 2 -Click bottom point of the beam

e Anew point “+” is created as shown
in the left figure.

e (Click Adjust Profile Manually in Edit
(tab) = Edit Frame

e 1 —sSelect the diagonal top bracing
e 2 -Click on existing end point
e 3 -Click on the new point

e The brace end will be shifted to the
new point.

e Repeat the above Step 1 to 3 for the
other bottom diagonal brace.

e The final positions of the diagonal
braces are as shown in the left figure.

e Double-click on 3D View in the
Explorer pane to go to the 3D view.

e Zoom in the same location & check
the diagonal braces final positions to
ensure they are correct.

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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Adjustment of Members Orientation and Coordinates

All member positions and orientation can also be changed without creating new points. We will make
such minor adjustments to some of the floor braces:

e Double-click on Storey 1 view to open that view
e Right-click and drag to rotate it a 3D view

e Zoom to the joint where the secondary, main beam and two horizontal “L” braces meet

e Press F9 & click on the joint to set it as a point of interest so that rotation is about this point
F9 & click here

Notice L braces orientation is not symmetrical with the other. We will rotate the brace, so that flange
of the brace is aligned with the flange of the beam.

e Select the brace

I e Press Ctrl + Q to rotate it until the correct

orientation is achieved as shown in the left
figure

e Repeat for the other brace

e The braces are coming in too close to the
secondary beam. We can shift it slightly away.

e Press Ctrl + W to offset the brace horizontally
until it is farthest away from the secondary
beam

e Repeat for the other brace

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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In ProtaSteel, in-Plane and Out-of-Plane holding points of the members and their offset from these
points can be adjusted in detail. Members can be defined in-plane and out-of-plane by holding one of
the Back, Front, or Middle points.

For example, the truss top chord out of plane alignment is set to top. Since U-shaped sections such as
UPN profiles are generally used at the edges of floor openings, In-Plane Alignments are determined as
Right or Left. The Out of Plane alighnment can be adjusted using the object properties window or pressing
CTRL+W from the keyboard. Similarly, In-Plane alignment can be adjusted using the CTRL+E shortcut
keys.

There is still a problem with the vertical position of the brace as it is too close to the top of the beams.
Braces usually should connect to the middle of the beams. This practice ensures force transfer along
member centres. In addition, fewer clashes will occur in the connection.

Profile ID: 771 [ProtaStructure 1D: 1X2 [L80X8]] x . .
e Double-click on the right L brace.
~ Load Save Save As Delete g
Geomet eneral Definitions etalling Definitions Analysis nabysis . . .
" GereraiDeinions DeingDerfons, Arals, Arelyeet Profile Properties dialog allows you to change :
Frafile Name ‘LEDXE ‘ I | Mormal ~
Hecht(y)  Widh(e)  WenTh(s) Flange Th.( e Profile /Section type by picking “...”
a0 80 8 8
Higrment et e Alignment (Out of Plane, In-plane, Rotation)
Qut of plane Micidlle Ctrl + W
npire EEEE o o Offsets Start & End
Faotation Top Ctrl + Q
- EAE. e Draw Frame Coordinate System
3 CO | O
Iy ! i |° e Change Frame Coordinate System to For
- - : 100 100 1 . .
I - - Analysis & design = Apply
Draw Frame Caordinale System - Notice 3 arrows showing local axis appear at the
Start Joint P80 End Joint TE  Lengh 65216 frame end. Red arrow = x-axis; Green arrow is y-axis;
Blue arrow is z-axis.
o] Apply Setas Default T Saneal L.
e If the axes are not visible, please ALT+D to
change to Wireframe
A minor shift in the vertical alignment can be
done by pressing Ctrl + W. However, if you try e EnterzStart & End Offset to 100 mm =
this, you will find that the offsets are too Apply
small. Further detail adjustment can be done Check the 3D view t b ) q
. . . . eck the 3D view to ensure brace is move
by exposing the Profile properties. down
e Repeat for the other brace (-100mm) = OK
to exit
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In-plane and out-of-plane alignment and offset values shift both ends of the members in a parallel plane.
In cases where the two ends will move differently, you can use the x, y, z “Start” and “End” offset values
at the bottom of the window. These values work in the direction of the members’ local axes. You usually
will not need to use these offset values. Necessary adjustments in these fields are made automatically
by macros.

While working in ProtaSteel, the In-Plane and Out-Plane will be enough for the position changes you will
make on the members.

Preserve constructive changes during model re-import

There is a one-way data transfer from ProtaStructure to ProtaSteel. Adding and removing a new
member to the project must be done in ProtaStructure. In this case, the project must be saved and
closed in ProtaSteel, and necessary changes must be made in ProtaStructure.

If it is desired to keep the changes made before in ProtaSteel (e.g., member position & orientation), the
“Preserve constructive changes during model re-import” option must be marked.

In the General Definitions tab, the option “Preserve constructive changes during model re-import” is by
default checked.

Profile ID: 209 [ProtaStructure ID: C101 [HE20DA . . . .
RS A e I < During the next import, the import log file
v || Load Save Save &g Delete WI” ShOW a Warning .
Geomelry Detailing Definitions  Analysis  Analysis 2
, : “Imported Frame's ID in *.cdf file[xxx]:
Name ‘Honzontal Bracing . .
— Frame is locked. Therefore, in plane, out of
Type H.Brace
Material 2% e plane and start/end offsets were not
Usage Structural Steel app lied.”
Discipline Structural Steel
Ignore the above warning (log file) if you
Color Use custom color ) .
— want the member offsets to be retained in
Class CH ProtaSteel.
Annotation v

i s If this option is unticked (disabled), offsets
User Defined 1. | J done in ProtaSteel will be discarded during
| \ the next re-import from ProtaStructure.

2
ProtaStructure 1D C101 [HE2004)]

| Preserve constructive changes during model re-import

Last Modified Time : 20.10.2021 10:54:20

Apply Set as Default Cancel
! *test-11_ImportErmorLog.txt - Not Defteri - o %
Dosya Dizen Bicim Goranom  Yardim
11 of 11 profiles successfully imported. "

1 of 1 grids successfully imported.
2 of 2 views successfully imported.

Errors and Warning:

Imported Frame's guid is: [ {7A78BB66-43F2-4334-97AF-5E55CEC23949} ] : Frame is locked.
Therefore, in plane, out of plane and start/end offsets were not applied.
Imported Frame's guid is: [ {5F2778F5-7E3F-4D36-AE14-3CE@215BF7AE} ] : Frame is locked.
Therefore, in plane, out of plane and start/end offsets were not applied.
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Steel Connections

Once we have finalized the position of the steel members, we can start “connecting” the steel members,
i.e., create connections. Connections can be created in two ways:

1. Automatically using the connection macros from Macro Gallery or IntelliConnect
2. Manually by using the Plates, Bolts, Welds & Cuts commands

The automatic connection macros will automatically create the appropriate connection. If internal
forces are transferred from ProtaStructure, they will be automatically considered in the connection
design.

Detail design check is performed for the following connections per Eurocode 3, AISC (LRFD), AISC (ASD),
BS5950.

e Beam to Beam Connections: End Plate, Stiffened End Plate, Fin Plate

Beam to Column Connections: End Plate, Stiffened End Plate, Fin Plate
e Beam to Beam End Plate Connection

e *Haunch Connection

e *Direct Welding Connection

e *Base Plate Connection

e Simple Base Plate Connection

e Flange Plate Moment Connection

e Extended End Plate Connection

e Bolted Gusset Plate Connection

e Corner Bolted Gusset Plate Connection
e Welded Gusset Plate Connection

e Corner Welded Gusset Plate Connection

A detailed design report can be produced for the connections mentioned above, including geometric
and capacity checks. In addition, intermediate calculations, references to the appropriate clauses of the
design code, and corresponding equations are shown for easy checking.

* Denotes : Check is provided but will not automatically design the number of bolts and size of the
plates. It will be provided with a default connection size and will require user to manually adjust the
connection in the connection macro setting if the design has failed.

For the above connections, the following basic material strength checks are performed:

e Plate bearing check

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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e Bolt shear & Bolt tension check
e Weld stress check
e Plate tension & plate bending check

The checks above are the basic material checks, not clause-by-clause code-specific checks. No design
report can be produced. You are advised to perform your additional calculation checks if required.

The force used in the automatic connections are obtained from the higher of the two values :
1. The critical design forces of the connected members imported from ProtaStructure
2. User-defined Capacity Ratio in the Profile Properties > Detailing Definitions.
Capacity Ratio = Design Force / Maximum Member Capacity (equal less than 1)
This approach prevents unrealistic design when the design forces are very small or negligible.
For example, in the determination of the number of the bolts for a simple beam to beam fin plate :
e The critical design shear imported from ProtaStructure is 30 kN. This requires 1 number of bolts.

e The Shear Capacity Ratio of the beam is set to 0.3. This works out to be 100 kN which requires
two bolts.

e The final design shear force used is 100kN; Two bolts are chosen.

There is no check or design at all for the following connections: Haunch Connection, Apex Haunch
Connection, Direct Welding Connection, Base Plate Without Design, Eaves Beam Connection, Profile Fit
Connection, Sag Rod Connection & Sag Rod Holes, Welded Pipe Connection, Beam to Wall Connection,
Apex Truss Gusset Connection & Truss End Plate with Gusset Plate Connection.

Before performing connection design, we should customize the default design parameter :
e Go to File = Settings = Project Preferences
e Ensure that Design Standards for Connections is set to EC3
e General Overdesign Factor for Connections = 1

The connections will generally design for 100% of the member capacity. This setting works in
combination with capacity ratios of the connecting members (changed via Profile dialog = Detailing
Definitions). The Capacity Ratio is automatically calculated = Design force divided by the actual capacity
of the member. Hence, Capacity Ratio x Overdesign Factor = Final Factor.

e For example, under Steel Detailing, ensure the following
e Plates : Preferred Plate Material = S355

e Bolts: Preferred Bolt Material = Class 8.8
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e General Weld: Preferred Weld Material = Class 42

e Apply > OK

Base Plate Connection

To create a base plate connection to columns, we can use the base plate macros from Macro Gallery.
There are four base plate macros in ProtaSteel for creating the base plate connection. This macro can
design and create calculation reports.

e Base Plate Connection (with design)
e Simple Base Plate Connection (with design)

e Hollow Section Base Plate (without design)
o Shear Key

Simple Base Plate  Hollow Section Base Plate Shear Key
(Designed) Base Plate

In ProtaSteel, restraints are indicated with the ball and cubic objects in green. If the connection is
defined as a moment connection in ProtaStructure, it is shown with a ball + cubic object. If the
connection is designed as a pinned connection, it is illustrated with only a ball object.

Using “Base Plate Macro”, all fixed and pinned connections are created.

e Select the “Base Plate Connection Macro”

e Select the column.

e The connection is created under of column.

Base Plate Connection Macro Without Design Properties X

Figue Plates Welds SecondaryWelds Anchorage Holes ShearKey ShearKeyWelds Design Macro Presets

/| Create P4 stifener as ane piece

Excluded P2 Stifeners 1
| Grout Hole Excluded P3 Stiffeners L 1
HoleDimeter [ |

0K Apply Get Cancel
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Simple Base Plate Connection (Designed)

The “Simple Base Plate Macro can create pinned connections”. This macro can design and create
calculation reports. All parameters can be changed in macro properties.

e Select the “Simple Base Plate Connection
Macro”

e Select the column.

e The connection is created under of column.

Simple Base Plate Connection Macro Properties for [D: 22148 x
General  AnchorBolts  Welds  ShearKep  Macio Preset
i
! Design Standard AISC_LRFD w
|
Minimurm Plate Thickness
I aximum Plate Thickness 100
_______ TP | " | RS S B Plate Material 3355 e
Concrete M aterial a0 >
L — Add Stiffeners
1
I
I
|
I
| i |
540
Plate Thickness
Ok Set az Default Cancel
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Fin Plate

We will create a fin plate connection between the main and the secondary beam.

e Right-left-click on the Fin Connection Macro under Beam to Beam Connections
from Macro Gallery Fin Plate

e The Fin Plate Macro dialog will appear, which allows you to customize the connections.

e Go to the Design Tab and ensure the following : | profile iD: 225 [Protastructure ID: K105] x
. v|[ Load || Save |[ Savess |[Dekte][...
o De5ign Standard = EC3 Geometry  General Definition: | Detailing Definitions Analysis  Analysis 2
. . . ) Parent 1D Exclude From Detailing
e Pick Get to make it default settings for this o
connection type for all projects from now on. DrwngGrop[s | Treicstobsimainat
Prefix Start Number  Actual Number Last Numbering
e Zoom in where the two braces and one Pt [P |[i |[o | Hever
secondary beam connect to the main beam. Assembly [0 ] Never
Adjustment / Connections
. S| C ity R ati 03 ial C. ity Rati
e Double-click on the secondary beam s o —
Behave As None
e In Profile Properties, go to the Detailing
Definitions tab. Diawlings
Exclude From Dimensioning Do Not Annotate
Slip Coefficient is blank and hence will follow the
Project Preferences = Bolts settings
0K Apply 4] Set as Default .

e The Capacity Ratio is 0.3 for this beam, by default.

e This will be used to calculate the minimum design shear used for the
connection.

e The Analysis tab shows the geometric properties of the member.

e Apply > OK

The capacity ratio works in combination with General Overdesign factor for Connections (in Project
Preference).

Hence, Capacity Ratio x Overdesign Factor = Final Factor.
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e Select “Fin Plate Connection”

1 — Select main beam

2 — Select secondary beam.

e Right-click 3 times (to pass other parameters of the
macro without entering values)

e The Fin Plate Connection will be created automatically.

e C(lick on the secondary beam, under the Detailing
Definitions tab, change the Shear Capacity Ratio to 0.1. This is because the shear capacity of the
secondary beam is much higher than the actual shear.

e |f you need to adjust the bolts and plate layout, click on the blue plate, press M and press Enter
to call out the Macro Properties.

FUTTOWRITIT TTIWIY " - P PE— ar—y P " — " M M -

Fin Plate Connection Macro Properties for 1D : 1332

General Baolt Flate  ‘“Weld Design Macro Preset

Flange/Stiffener Catch Tolerance
200

Catch Top Flange

Catch Bottom Flange

Bolt Alignment/Offset

Fut Flate Reverse Side
IE Cut Bottom Flange of Beam

Top ~
30

li‘ Create Botttorn Horizontal Stiffener ‘Width
|i| Create Fin Plate Stiffener Wwidth 70
Ok | | Apply | | Setas Default H “Cancel |
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Corner Bolted Gusset Plate Connection (Horizontal Brace)

We will insert a corner bolted gusset plate for the L brace that uses the beam fin plate as
the boundary Corner Bolted

Gusset Plate

e Pick Corner Bolted Gusset Plate Connection
under Bracing Connections from Macro
Gallery

1 — Pick the main beam
2 — Pick the brace

3 — Pick the blue fin plate

L S The connection is created. Repeat the same for

the other brace.

e The connection consists of plates, bolts & welds. Each members has its individual properties and
can be selected, deleted, or changed. Double-clicking it will reveal the member properties.

e The entire connection is represented by the macro sign <} Double-clicking on it will bring out
the Macro dialog box where the entire connection can be changed.

e |tis highly recommended you review settings of the connection macro before executing it.

Beam to Beam End Plate Connection
We will create Beam to Beam End Plate Connection between the primary and secondary
beam.

Zoom to the adjacent joint where the secondary & primary beam meet. o

e Pick Stiffened End Plate Connection under Beam to
Beam Connections from Macro Gallery

1 — Pick the main beam

2 — Pick the secondary beam

The connection is created. This maybe a preferable in terms
of load transfer & ease of assembly & construction.
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Haunch Connection

We will create a haunch connection between the column and beam.

Haunch

Let’s change macro default values before creating the connection. We can also change the properties
after making the connection.

Haunch Connection Macro Properties . .
Fupre [T Ptes ot Wais St Pl Soterer Wl oo P e Right click on the Haunch
L Connection under Beam to
:I I Column Connections from
5 — Macro Gallery
[
Comer Stiffener Parameters .
e Goto Figure 2 tab
o Top o e Ensure that all the end plates
Uss singls plats instsad of stiffensr A .
[ Creste Comer Stifener A' B,C & Dis CheCked
e Apply 2 OK to exit
0K | Apply \ Get Cance

We will now insert the haunch connection.

e Pick Haunch Connection
1 - Pick the column

2 — Pick the beam

e The connection is created. The blue
transparent box is the cut object. This can be
turn on/off in Visibility dialog.

Repeat the same for the other end of beam to
column joint
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Stiffened End Plate Connection

We will create a stiffened end plate connection at the column beam joint at grid C/3.

Stiffened End Plate

e Double-click on Axis 3 view to open view

e Zoom in the joint where the column, beam
and 2 diagonal braces meet at grid C/3

e Press F9 on this joint to set the point of
interest

e Rotate the view slightly about this joint

e Pick Stiffened end plate connection from
Macro Gallery

1 — Pick the column

2 — Pick the beam

e Right-click 2 Connection is created

Corner Bolted Gusset Plate Connection (Vertical Brace)

We will connect the diagonal brace at the same joint. There is a problem because the
existing connection is getting in the way, i.e., we cannot connect the diagonal brace
directly to the column due to the top stiffener plate. This can be solved by using the Corner
Bolted Gusset Plate Connection.

Corner Bolted
Gusset Plate

e Rotate the view around so the connection is not
obstructed by the girt

e Pick Corner Bolted Gusset Plate Connection
under Bracing Connections from Macro Gallery

1 — Pick the column
2 — Pick the top brace

3 — Pick top orange plate

e Alogical & constructible gusset plate connection
will be created joining the top plate of the
previous connection.

e After the connections are successfully inserted.
Change the number of bolts in the macro
properties.
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Bolted Gusset Plate Connection

It is slightly different for the bottom brace as it should directly connect to the beam
flange’s bottom.

Bolted Gusset
Plate

Hence, we should use the Bolted Gusset Plate Connection.

e Rotate the view around the connection so
you are viewing the bottom of the brace

e Pick Bolted Gusset Plate Connection under
Bracing Connections from Macro Gallery

1 — Pick the beam

2 — Pick the bottom brace
e Right-click

e Alogical & constructible gusset plate
connection will be created joining the
bottom flange of the beam.

e Press ESC to cancel the macro

For constructability, let’s push back & shorten the green gusset plate to terminate precisely at the beam
end.

e Select connection macro by selecting the macro sign - - Press Enter

e Alternatively, select the gusset plate > press “M” > Press Enter (wait for the macro dialog)

Bolted Gusset Plate Connection Macro Properties X

Figure  Pars  Secondary1 Secondary2 Secondary3 Secondaryd Secondaryt Secondary 6 Welds! ‘Welds2 Design Parameters  Macro Presets

T

v
Ao

Frofile Priority l:l
l:l | Conwvex Hull
I I:I . U or Box Connection Style W | Syrmmetric Gusset on Equal Angles

B Pullweb members to out of web
®) Auto ®) Auto

Connection Place Flip Yirtual Profile
I:I Single Gusset Rectangular Gusset P
Double Gusset hlormal Gusset
oK Apply Get Cancel COpen |1 or Box Setings

Enter 25mm in the above plate set-back value > Apply
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The plate is shortened, and the stiffener plate is added.

e This is more constructible because the
gusset plate & stiffenner can be
assembled off-site as part of the beam
assembly.

e The previous stiffened end plates will be
part of the column assembly.

e Hence, when the column & beam are
brought to site, it’'s easy & quick to install
& “connect” them together.

Splice Connection

A splice connection must first be inserted in a column or beam in ProtaStructure. A splice
connection has been inserted to all columns 1200mm above the 1st storey for this model.

Splice

e Zoom a column, slightly above Storey 1

o Notice the column is broken into 2 separate elements
as a column splice was created in ProtaStructure.

e Pick Splice Connection under Splice Connections from
Macro Gallery

1 — Pick the top column

2 — Pick the bottom column

e The column splice connection is added.
e Press ESC to cancel the macro

e Repeat the same for the other columns

e The green color bolts are called Workshop Bolt. These bolts are pre-installed in the workshop
before being brought to the site.

e  The orange bolts represent the bolts to be assembled on site.
The above setting and other bolt parameters can be viewed and changed in the Bolt Group property :
e  Double-click on any of the bolts = Bolt Group property will appear.
e  Goto Settings 2 tab = Assembly Location = two choices are in the dropdown menu :
e Workshop

e Site
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Splice Connection Macro Properties X
Figue Bolt  Plate Design Macro Presets
Bolt Material v
. . Thread In Material

Flange Bolt Properties ‘Web Bolt Properties L HEac o
Balt Assembly | | .. | | .. || Third Washer
Bolt Pretension I ] I I Second Nut
Bolt Diameter I v I v
Bolt Tolerance l ] | I
Hole Type v v
Connection Type v v
Assembly Location Site v Site v L | Second Washer

Slot Hole Along X

Workshoj
S HoloAong TR

Mawimum Bolt Size Minimum Bolt Size

I | |
oK Apply l Get l Cancel

Apex Truss Gusset Connection
We can connect the truss members at the ridge point with the Apex Truss Gusset _

Connection Macro. This macro adds a plate between the members, allowing the  ApexTrussGusset

members to be welded to the plate. The basic principle when creating a macro is to select
the primary members first.

Zoom into the truss ridge point.

¢ Click on the Apex Truss Gusset Connection Macro
¢ Select the top chord members (1 and 2) of truss.

e Select the vertical members (3) connected to the
ridge.

¢ Right click on an empty place on the screen as
there is no other members to connect.

e Press the ESC key to exit the macro.

To increase the width of the gusset plate, let’s open the macro properties and change the plate 50 mm
right and left.

e  Double-click the macro icon to open the properties of the connection macro.

e  Alternatively, select the gusset plate and press the “M” key on the keyboard. Then press the Enter
key to open the macro properties window.

e Inthefield shown in the picture, enter the distance of the plate edge as 50 mm and press the Apply
button.
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e  Tochange the connection design depending on the macro, you can make the necessary changes in
the properties window.

e  This macro can be created as both welded and bolted.

Apex Truss Gusset Connection Macro Properties *

General ‘Welds Truss1 Truss2 Truss3 Plate  Macro Presst

Top Chord Fitting l:l

Cap Plate

i

L

IE‘ Corwes Gusset Plate
IE‘ Rectengular Gusset Plats
IE‘ Diouble Gusset Plate

[m] Puil wet members to out of web

oK H Apply || Set az Default || Cancel

Truss End Plate With Gusset Plate

Truss End Plate with Gusset Plate connection macro connects column and secondary
trusses with gusset and endplates. This macro provides a bolted connection to the

column flange with an endplate. Trss End late wih

e Pick Truss End Plate with Gusset Plate under
Truss Connections from Macro Gallery

1 — Pick the main column

2 — Pick the top chord

3 — Pick the diagonal

e Right-click to end and create the connection
4 — Pick the main column

5 — Pick the bottom chord

¢ Right-click to end & create the connection

The two connections are created as shown.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"



2 rRoTA page - 40

Welded Pipe Connection
Welded pipe connection macro can be used to connect tube profiles.

Welded Pipe

o Click on Welded Pipe Profile macro under Truss
Connections from Macro Gallery

1 — Select the main top member

2 + 3 — Select the secondary profile, e.g. diagonal
and vertical element.

e Right-click to end and create the connection

Profiles are automatically cut and trimmed around the
joint.

When the connection is created, cutting objects will form around the pipe profiles. Secondary profiles
should be selected according to cutting priority.

The diagonal and verticals are cut around the primary pipe profile.

Beam to RC Wall/Column Connection

This connection macro creates and designs an embedded steel connection between a steel
beam and a concrete wall or column. The steel member must be perpendicular to the

reinforced concrete surface. It is essential to have enough space on the concrete surface;
else, the macro will not work.

Beam to Wall

e C(Click on Beam to Wall Connection under
Beam to Column Connection from Macro
Gallery

1 — Select the concrete wall or column

2 — Select the steel beam

e Right-click to end and create the connection
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Stiffener

In ProtaSteel, macros automatically add required stiffeners. If it is desired to add the
stiffener to any of the members independently of the macros, or if it is needed while
creating a manual connection, the stiffener macro can be used. This macro creates
stiffeners at the specified point on the specified profile.

Stiffener

There must be a catchable point in the region where stiffener will be created. If there is no point on the
object, we can create a catchable point with point objects or construction line object

e C(lick on Stiffener under Detailing from Macro
Gallery

1 — Select a member which want to add a
stiffener

2 —Select the point on the member

e C(lick on Stiffener under Detailing from Macro
Gallery

1 — Select a profile which want to add a

stiffener

We can also use the “dx..”, “dy..”, “dz.” 2 —Go to a point on the profile.

command to distance.
3 — Press ENTER and write “dz-100”
To create a stiffener at any point on the

profile, press the CTRL key and left click on 4 — Press ENTER
any snapped point on the profile.
e The stiffener is created as shown below.
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Stiffener Properties

Figure  ‘welds Macro Presets

®) Both-Sided
Single-Sidec

|

Apply

Full Stiffener
Half Stiffener

Half Stifferer
Length Ratio

[l Get

Frant

®) Middle

Behind

Thickness
Mame

I aterial

Part Pos

Part Start
Azzembly Pos
Azzembly Start
Chamfer Type
dx

dy

Cancel

5235

-

Insert Sag Rods

In ProtaStructure, the main steel members are modelled and designed, usually omitting
the minor or non-structural members to keep the model size manageable and efficient. 1
After the model is transferred to ProtaSteel, you might want to add ancillary steel —

members such as sag rods.

Page - 42

Stiffeners can be placed on both sides of the
profile or one side. You can change these
options on the macro properties.

The out-of-plane movement of the stiffeners
can be changed with the front-middle-back
commands. CTRL+W key combination can
use to change the out-of-the-plane direction.
You can select all members of the macro
connection  with the CTRL+M  key
combination.

Create Sag Rods

We will insert some sag rods between the girts along axis 3 :

e Double-click on 3D view in the Explorer pane to go to the default 3D view

e Right-click on Create Sag Rod icon under Purlin and Girt Connection from Macro Gallery = This

will expose the Sag Rod Macro Dialog.

e Key-in the offsets 50 mm and Number of Intervals = 3 (as shown below)

e Untick the diagonal so that it will not be included

e Choose the section profile by clicking on “...” (as shown above) = Pick Round Bar D10 - Select

e Pick Get to make these input the default from now on = OK

Multiple Sag Rod Creation Macro Properties

Figure  Profile  Macro Presets

[

dl

E
I

o3

Nurnber of Intsrvals

Interval Distances |

te.g. dl d2.. orn1*d1 n2*dz..)

OK. Appl Get

Cancel

—

o

@& Select Profile

> - | Profiles
5 - L Profiles
+ L1 U Prafiles

~ @ Pound Bar Profiles

~ (9 D (54)

@ D20
@ D5
@ D30
@ D
@ D40
@ D45
@ 050
@ 055
@ D50
@ 0is
@ or
@0
-4 D80
@ D85
@ D90
.. D95
.4 D10

5+ T TProfiles

<

n]
o]

> - UNDEFINED ROUND_BAR PROFILES (26
> € Round Tube Profiles
5 [0 Souare Tube Profiles

Geormetric

Dio

Round Bar Profiles
D54

Profile Name
Type
Family

Height 10
Wicith 10
\Web Thickness 0
Flange Thickness
Fiadius 1

Radius 2

Fiadius 3

Slope

Centroid Dist 22
Centraid Dist 33

cooocoocooo

0

oo ]l

Cancel Refresh 3>
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e Left click on the Sag Rod icon

e Notice the cursor turn to a hand icon @
meaning that it is waiting for required
element selection action(s).

1 — Left-click on bottommost girt

2 — Left-click on topmost girt

e Right-click 2 Sag Rods will be inserted

Insert sag rods for another panel between
grid B, C & D using the same steps above,
i.e. start by picking the bottommost girt
(no need to pick the sag rod icon again)

e Once complete, press ESC to cancel the
Sag Rod macro action.

Notice the cursor changes back to default

arrow *

Each sag rod has its individual properties and can be selected, deleted, or changed.

Double-clicking it will reveal its properties.

All the sag rods are represented by the macro sign - They can be changed in a group by selecting this
macro sign > press “Enter” as stated previously.

You can use Sag Rod Connection or Sag Rod Holes macros to connect to sag rods and girts/purlins.

Sag Rod Holes /
In ProtaSteel, “Sagrod Hole Macro” is used to drill holes on the members to connect the

sag rod. This macro is located in the “Purlin and Girt Connections” menu in the macro Sag Rod Holes
library.

Macro default settings can change before adding the macros. Left click on the “Sag Rod Hole” icon to
change the macro presets.

1 — Left-click on the “Sag Rod Hole” icon

2 — Select purlin or girt member

Holes will be opened on the member at the points where the sag
rod connected.
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Select the hole and hit M + ENTER keys on the keyboard to open macro properties. Macro default
settings are set to “by working points”. This setting represents the points where the sag-rod connected.

Sag Rod Heles Macro Properties b4

Figure  Macro Presets

Settings

' ! According to Existing Sag Rods

! | by Digtance
Profile Type | R |
Staggeing: mw s m oo
lE‘ Clouble Haoles )ﬂ! T ﬂ
Hale Orientation
Haole Taolerance : Distances - | |

{ ! by Segmenting

# of zegment
Double Holes

. b wforking Poinks

M axirurn Digtance for Bolt Grouping: I:l

Ok | Apply | Get | Cancel |

Sag rod holes can be created on members other than purlins and girts. In the macro library, right-clicking
on the sag rod hole macro opens the macro properties window to create sag rod holes in different
members. “According to the existing sag rods” option is enabled, and the profile type is selected.

For example, let’s select “beam”
¢ On the hole orientation layout, select the hole diameter is 14mm, the hole tolerance is 2mm (total

hole diameter 16 mm is drawn).

e Set the hole’s distance to the profile centre line as 50 mm and the horizontal distance between the
holes as 200 mm.

e Then check the “Get” option. Thus, we have changed the default settings of the macro.

Sag Rod Heles Macro Properties for Macro [D : 23694 *

Figwe  Macra Presets

Setlings

According to Existing Sag Rods

( ! by Digtance
Staggering l o s 100
Double Holes %

Hole Origntation

Hole Talerance

Distances : |

( ! by Segmenting

# of segment :
Doubls Holes

( ! by Working Paints

P aximum Distance for Bolt Grouping: |:|

oK

Get ‘ Cancel ‘
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To create more than one hole group, the operation can be done by entering the distance or the number

of groups.

For example,

e After the hole settings are made for a group on a beam, select the “by segmenting” option.

e Write “10” in “#of the segment”.

Thus, ten holes are drilled at equal intervals.

Sag Rod Holes Macro Properties for Macro D : 23694

Figue  Macro Fresets
Settings

According o Existing Sag Rods

Profile Type : Beamn ~
Staggering : ~

~| Double Holes

Hole Orientation

Hole Tolerance :

Mazximum Distance for Bolt Grouping: l:l

(S T Get Cancel

by Distance

0) by Segmenting

# of segment 10
/| Double Holes
by working Points

Sag Rod Connection

In ProtaSteel, “sag rod connection macro” can also be used to drill holes for the
connections of the sag rods connected to purlins and girts.

This macro can be used for the connections of the sag rod members connected

Sag Rod Connection

vertically and diagonal to purlins and girts.

Different connection types can be applied by changing the macro properties.

Different types of connections are shown below.
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Sag Rod Connection Macro Properties for ID:

(Figuie’| Plate  Weld Profiie Macro Presels

Sag Aod Type

Onlp Opened Hole

Hole On Additional U-Profile

Hole On Additional Plates

HoleToleranee | | Tl

oK Apply Get Cancel

Sag Rod Connection Macro Properties for 1D : 23911 X

Figue Plate ‘Wweld Profle Macro Pressts

Sag Fiod Type

Only Opened Hale

Hole On &dditional Plates

]

oK Get Cancel

Sag Rod Connection Macro Properties for ID: 23914 x

Figwe Plate  ‘Weld Profle Macio Presets

SagFiod Type
Only Opened Hole
Hale On Additional U-Profil=
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IntelliConnect For Fully Automated Steel Connection Design

IntelliConnect automatically assesses joints to your preferences and creates and designs steel
connections in batches. It covers a wide range of simple, moment, splice, and weld connections. It
considers constructability by intelligently arranging and configuring all the components of the
connections without user intervention. This results in a vast improvement in productivity as it minimizes
the time required to create & correct these connections manually.

IntelliConnect Floor Wizard X

Which type of simple connections do you want o use for bracings?

Why use IntelliConnect?

Steel detailing software typically creates connections automatically between two elements by applying
specific rules, i.e., “Rule-based joints”. These rules usually include names of the profiles, moment
releases or lack thereof, the loads in the elements, and approach conditions (whether the secondary is
approaching the main from the flange or the web).

Figure 1 Figure 2

While “Rule-based joints” are beneficial in simple cases where the main and the secondary (incoming
profile) are the only two profiles present at a joint (see Figure 1 above), they fail to deliver for complex
joints when more than two elements meet at the same joint (see Figure 2) :
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e Applying a blind “Rule-based joint” would create many clashes for complex joints, resulting in
wasted & unproductive time in manual amendments.

e “Rule-based joints” will not have the intelligence to “auto-shift” the secondary member slightly to
facilitate a connection. Such requirements are commonplace in steel detailing when incoming
members need to be shifted slightly to avoid clashes and make erection possible.

e Atypical example (see Figure 3) would be the need to shift the horizontal bracing in flooring systems
away from the beam-beam intersection points to avoid clashes with the connection plate.

e “Rule-based Joints” typically do not combine incoming elements to create a single shared
connection if the situation demands it.

For example (in figure below), two horizontal braces will connect to the same point separately, creating
a clash between the gusset plates rather than using a single shared gusset plate.

IntelliConnect is an advanced technology that attempts to address issues common in building detailing.
IntelliConnect automatically determines which connection type is more appropriate for the selected
profiles by checking their type, location, and orientation. If necessary, it automatically alters connection
parameters and creates a more feasible & practical connection.

IntelliConnect Scope

IntelliConnect can automatically create connections for various types of elements and profiles.
IntelliConnect can provide a solution for 36 different cases grouped in 9 categories. These categories
can be listed as follows:

. Splice connections

o Batten plate connections

o Sag rod connections

. Vertical bracing connections
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Truss connections
Purlin and girt connections

Floor beam connections (with horizontal bracing
connections if there are any)

Beam-Column connections (with horizontal and
vertical bracings if there are any)

Base plate connections (with vertical bracings if
there are any)

These include “simple cases,” e.g., where there are only two primary elements, and “complex cases”

where more elements meet at the same node.

Cases Covered

The following “Simple Cases” are covered by IntelliConnect :

1.

9.

Splice connection (Supports whatever profiles are supported by the Splice macro)
Column Base Plate with no incoming vertical bracing. (The column needs to be an | section)

A single beam framing into a main beam. The Beams can be | or channel profiles. The type of
beam to beam connection can be the following 1) The Stiffened end plate connection. 2) The
Fin plate connection 3) The beam to beam end plate connection.

A single beam framing into a column. The profiles may be | or channel profiles. The type of beam
to beam connection can be the following 1) The Stiffened end plate connection. 2) The Fin plate
connection 3) The beam to beam end plate connection.

A single horizontal brace framing into a beam. The horizontal brace may be any profile
supported by the Bolted gusset or welded gusset macros)

A single vertical brace framing into a column. The vertical brace may be any profile supported
by the bolted or welded gusset macros.

A single purlin sitting on a beam or truss element. The type of connection may be any
connection supported by the Purlin/Girt macro

A single girt framing into a column. The type of connection may be any connection supported
by the Purlin/Girt macro

Creation of batten plates on twin profiles.

10. Connection of a single purlin passing continuously over a truss top chord or roof beam.
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IntelliConnect covers the following “complex” cases:

9.

Two horizontal braces framing into a beam (from any side — web or flange)
Two vertical braces framing into a column (from any side — web or flange)

Truss connecting with more than one truss secondary framing into the truss top or bottom
chord.

Two purlins sitting on a truss top chord or a roof beam
Two girts framing into a column (either colinear or one from each orthogonal direction )
Two floor beams framing into a main beam from opposite sides

Combinations of floor beams and horizontal braces framing into each other at the same point
from both sides

Up to 4 beams framing into a column (two from the flange side and two from the web side)

Combination of beams and vertical braces framing into a column

As far as limitations on profile types and connection types are concerned, the same restrictions apply in

simple cases.

How to use

The following is the summary of how to use Intelliconnect :

The user will first select single or multiple nodes that hold all elements that meet at a single
point.

After that, the user right-clicks and goes into the IntelliConnect context-sensitive menu and
selects the type of connections to create.

For some IntelliConnect connections, however, the user needs to select frames and not nodes
(e.g., simple cases 9 and 10 stated previously)

IntelliConnect will use its “internal classifying algorithm” to connect as many of the nodes
selected by the user as possible.

However, if it encounters an unsupported case, it will either partially connect the node or leave
it completely unconnected.

A detailed report will automatically be displayed listing nodes that are successfully connected
or failed to connect.

IntelliConnect Node Control tool is an interactive navigator to browse & examine points that
are partially connected or not connected; so the user can connect/correct them manually.
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Truss Example
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e Select the nodes (joints) of the steel structure where you wish to create a connection

o Joints are shown as blue dots at the end of the member. You can click and drag a box

to select all members and the nodes for simplicity.

o We will create the truss connections based on the Quick Start Guide Steel model for

illustration purposes.
e Gotothe 3D view

e Select all the truss members by dragging a box around them

Show Selected
Hide Selected
Show Only Selected
Show All

T Measure Distance Alt+R
Measure Angle

Copy

Copy Special »

Move

Move Special »

Match Elements

Delete Del

Clash Check

Set Work Plane 4

Create Views »
@

e Right-click = IntelliConnect = Pick Create Truss Connections

Create Purlin Connections
Create Girt Connections
Create Sag Rod Connections
Create Batten Plates

Create Stringer Holes

Create Splice Connections
Create Base Plate Connections
Create Bracing Connections

Create Truss Connections

Create Floor Beam Connections
Create Column/Beam Connections

Clear Mode Informations
Node Control

e Type in the preferred Gusset Plate Thickness in the Truss Wizard or leave it blank if you want

IntelliConnect to select thickness for you.

Gusset Plate Thickness:

IntelliConnect Truss Wizard X

]
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Purlin Example

e Select the nodes (joints) of the steel structure where you wish to create a connection

o Joints are shown as blue dots at the end of the member. You can click and drag a box
to select all members and select the nodes for simplicity.

o We will create the purlin connections based on the Quick Start Guide Steel model for
illustration purposes.

e Gotothe 3D view

e Select all the truss members and purlins by dragging a box around them

I Measure Distance Alt+R | Create Purlin Connections
Measure Angle Create Girt Connections
Create Sag Rod Connections
Copy

Create Batten Plates

Eopy Special Create Stringer Holes
Move ) Create Splice Connections
Move Special % Create Base Plate Connections

Match Elements Create Bracing Connections

Delete Del Create Truss Connections

Clash Check Create Floor Beam Connections

Set Work Plane . Create Column/Beam Connections
Create Views > Clear Node Informations

Creste Drawings I

e Right-click = IntelliConnect = Pick Create Purlin Connection

IntelliConnect Purlin Wizard x IntelliConnect Purlin Wizard x
Which type of connection do you want to use? General Options
v Apply Dffset for End Purling
= ) - ' . = ¢ )
® »
. . _ - — * @
= = == —
@ Angle Type " Folded Plate Type " Bracket Type
Angle Type Options
Maximum Angle Leg Length :
" Bracket Type Without Cut o Profile T © Aut
—_— ity ° Profile Name : E‘
N,,d | Previous | | Run

e |n the Purlin Wizard, choose the preferred type of connection
e For this example, select “Angle Type” & “Reversed Cleat.”
e Input further parameters in the following wizard dialog = Run

e Max Angle Leg Length or profile can be specified
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e AutoConnectlog text file will open = Review its contents as it lists all the connections that are
successfully / unsuccessfully created

J AutoConnectlLog.txt - Notepad - O

File Edit Format View Help
Connecting Nodes started at 16:@8:56

11 Node 61@ by CASE @5:Purlins and Girts...Done
: Node 620 by CASE @5:Purlins and Girts...Done
: Node 514 by CASE @7:Top or Bottom Truss Chord...Done
4:: Node 506 by CASE ©7:Top or Bottom Truss Chord...Done

Connecting Nodes finished at 16:08:56

FAC S ivis ¥ O =

Beam-Column—Brace Example

We will auto-create a beam-column—brace connection for illustration purposes based on the Quick Start
Guide Steel model.

e Goto Storey 1 view = Select all the column and beam joints along axis 2

Set Work Plane . I

IntelliConnect Create Purlin Connections

Create Girt Connections

Draw Type

Create Sag Rod Connections
Ly e=eii Create Splice Connections
Create Base Plate Connections
Create Bracing Connections
Create Truss Connections

Create Floor Beam Connections

Create Column/Beam Connections

e Right-click =2 IntelliConnect = Pick Create Column/Beam Connection

If there is more than one possible connection configuration, the following dialog allows you to choose
which connection type to consider and its priority.
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IntedliConnect Beam-Column Wizard

Which type of fixed connections do you want to use?

Haunch C

Flange Piale Momen! Connectan Maco

Finadl Connecton Priary List
Extended End Flale Carnection Macra
Haurich Connectan bscro

Direct welding Cornection Macra

[ ]

IntelliConnect Beam-Column Wizard

Which type of simple connections do you want to use?

Stifiened End Piete Conngetion Macro

Fin Plete Connection Maero

Simple Comection Priany
Siienes End Pate Commatonias
Fin Fioie Cannectan Mor

e  Pick the connection types to consider = Adjust the priority using up/down arrow = Next

The relevant bracing shifting, bracing connection & haunch connecting settings will appear next

e Make desired adjustment = Run = Then connections will be created

IntelliConnect Beam-Column Wizard

Bracing Shifting Settings

Navar Shifl

Bracing Connection Settings

Assignme

‘acearding o main mamear

Hauneh Connection Macro Settings

Beam — Beam — Brace Example

We will auto-create a beam-beam-brace connection based on the Quick Start Guide Steel model for

illustration purposes.

e Goto Storey 1 view = Select all the beam and beam joints along axis 2

ProtaStructure” ProtaSteel
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“i& Save Bitmap to Clipboard
Select Origin of Interest  F9

Show Selected
Hide Selected
Show Only Selected
Show All

T Measure Distance Alt+R

Measure Angle

Copy

Copy Special
Move

Move Special
Match Elements

Delete Del

Clash Check
Set Work Plane
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Create Purlin Connections
Create Girt Connections
Create Sag Rod Connections
Create Splice Connections
Create Base Plate Connections
Create Bracing Connections
Create Truss Connections

Create Floor Beam Connections

Create Column/Beam Connections

Clear Node Informations
Node Control

e Right-click = IntelliConnect = Pick Create Floor Beam Connection

When there is more than one possible connection configuration, the following dialog allows you to
choose which connection type to consider and its priority.

ntelliConnect Floor Wizard

Which type of simple connections do you want to use?

¥

Siflened Endl Plote Conniecion Mecr Fin Plate Conneclion Macro

Baoim o Baem End Plafa Connecion Macro

X || intelliCannect Floor Wizard x

Which type of simple connections do you want to use for bracings?

Connection Prioty List

Fin an o)
Sttened Erd Fiae Conecion Maze Eovad Gus3at Fioks Comection Morto

Bieom o Bieam Endt Plate Conngation Macr|

i

y

Balled Gusse! Fiste Connecian Mscro l Comes Hohed Gusset Fiate Connacion Macro

e Pick the connection types to consider = Adjust the priority using up/down arrow = Next
The relevant bracing shifting, bracing connection settings will appear next

e Make desired adjustment = Run = Then connections will be created

ProtaStructure’
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IntelliConnes

eliConnect Floor Wizard
Shifting Seftings
over S Shif

+* Floor Beam Connections (IntelliConnect) works when beam
to beam connection is hinged in ProtaStructure.

% Change to “Line Mode” (ALT+D) = Green Dot shows hinged
connection.

IntelliConnect and Connection Ordering

Although detailing order often depends on the structure itself, it is usually better to start from large
connections to small ones. The connection order depends on the size and shape of the structure. For
example, for the high-rise buildings, beginning the connection process from the bottom is more
practical. Most structures will have similar, symmetrical, or identical axes. Whether you use
IntelliConnect, finishing the frame connections first is a good practice.

In a typical warehouse structure with a truss, the recommended connection order is given below :

Splice connections (Columns, Beams and Truss members)

. Truss connections

o Apex connections

. Truss top and bottom chord connections to columns

o Base plate connections

. Manual (User-defined) connections (User-defined connections can be saved for later use and

repeatedly used for similar joints)

. Connections of the compression members located between the column or truss system.
. Vertical and roof bracing connections

o Purlin or girt connections

. Sag Rod Connections

. Batten Plate Connections
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For building type multi-story structures, the recommended order to use IntelliConnect is given below;

. Splice Connections

° beam-to-column connections (Moment connections first)
o Beam-to-Beam connections

. Horizontal bracing connections

. Base Plate Connections

. Vertical bracing connections

. Purlin, sag rods, and batten plate connections

When working with IntelliConnect, it may be necessary to change the order for two reasons:

° The IntelliConnect operates on a joint. All connections on this joint are simultaneously taken
into account. For instance, in the case of column-beam connection (beams connecting to both
sides of the column) with vertical bracing, IntelliConnect will create all connections
simultaneously to prevent clashing by using shared parts. That will change the detailing order.

. Since IntelliConnect operates on a joint, it is unclear whether the other joints are too close or
too far away. If the members or joints are close enough to collide with each other, IntelliConnect
may face conflict problems. In this case, the Clash Check command can detect collisions.
IntelliConnect can run with the user’s requested order so that it does not use the connection
information of other joints.

In summary, connection design should be initiated from the primary connections. IntelliConnect can be
triggered on a grid or storey basis. The girt, purlin, and sag rod connections can follow. Batten plate
connections should be created finally.

Manual Connection (Info Only)

In ProtaSteel, users can create connections manually and save them in the macro library to reuse them
at similar nodes. A steel beam to RC column manual connection will be demonstrated below.

Steel Beam to RC Column Manual Connection

Steel beam to reinforced concrete column connection can be done using manual embedded steel plate
connection in ProtaSteel.

The following example illustrates the steps of creating an embedded steel plate connection.
1. Firstly, we can cut off excessive steel beam using the Object Cut command (in Edit tab)
I First, select Member to Cut.
. Second, select the Cutting Member.

lll.  Select “No” from the pop-out warning to remain the Cutting Member.
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Clean Up

Do you want to delete the cutting object?

Remember to turn off the “Cut” in Visibility Filter when necessary.

LB v
2. Create the section view plane with the command By Two Points *= /'€ %/ 27t

the View tab = View By 2 Points

by accessed from

e Pick a point between the end of the steel beam and the surface of the concrete.

e Double click on the background to open the View Properties = save View Name: Cut Section
A or any preferred name. (Refer to chapter 7 — Creating new Views)

3. In the Cut Section A View, navigate to the Views tab = select To View Plane. This sets an active
work plane based on the current view.

<
=

ie

= By Three Points

~ To View Plane

s= To Global

Moare
Options ™
Set Workplane

4. Select the plate command (in the Steel tab) and select the four corners of the steel beam
clockwise = A plate will be created. Then right-click on the beam and select Hide Selected.
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L Interrupt

i Set View Properties

Zu Inguire

=& Save Bitmap to Clipboard
Select Origin of Interest  F9

Show Selected

Hide Selected

Show Only Selected
Show All
Select Assembly

T Measure Distance Alt+R
Measure Angle

B

5. Use ALT to select each corner and Right-click > Move Special = Linear to move each corner

accordingly.
e |eft Top Corner — X:-30, Y: 50
e Right Top Corner — X: 30, Y: 50

e Right Bottom Corner— X: 30, Y:-50
e |left Bottom Corner—  X:-30, Y:-50

Directions X, y, z must always check based on the workplane (axis direction icon) shown in the
modelling view. The axis can be based on colour: Red = x, Green =y, Blue = z.

Then, right-click in the background to Show All.

1 Interrupt
& Set View Properties

% Inquire

=§ Save Bitmap to Clipboard
Select Origin of Interest ~ F9

Show All
B Measure Distance Alt+R

Measure Angle

Set Work Plane
Manual Macro

6. Right-click on the plate, set:

e Position In Depth: “Behind”
(Alternatively, can be adjusted via hotkey CTRL+W in modelling view)

e Thickness (t): 10

7. Go to 3D views, remove the overlapping concrete using the Object Cut command.
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e First, select the concrete member.
e Second, select the steel plate.

e Select “No” from the pop-out warning to remain the Cutting Member.

8. Go to the Section Elevation View and go to Edit tab = Point = hold Shift key + left click on
_—

Geometry

Pasition In Depth
Thicknass () ITU

Type ®) Contour Plate

Folded Plate
FoldeaThidaess ) [0 | ﬁ

Draw Coordinate Systermn

Oﬂset

“Dividing Points command to set to “4” in Number of Points? and press OK.
Left click on the command to start creating reference points.

e Step 1 - start at the left top corner of the steel plate and end at the left bottom corner of
the plate.

e Step 2 - start at the first point created from the top corner of the plate, drag horizontally
and end at the right side of the steel plate.

e Step 3 - Repeat step 2 but start at the Fourth node, created at step 1 instead.

e Delete all points created in Step 1. Delete 2" and 3" nodes created in Step 1 and Step 2

9. After finished creating the reference points, we can now create steel studs. Hold Shift + Left click
on joist (in Steel tab) to access the Default Joist Setting and set:
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e Profile name: D10
e Qut of plane: Middle

Default Joist Settings

~ || Load Save Savy

Geometry General Definitions Detailing Definitions  Analysis Al

Frofile Name | | T
Height (h) Width () Wb Th. (s)
10 10 0
Alignment Offsets
In plane tiddle W

P ]
b ]

Faotation Top ™

10. Left-click on the reference point at the left top corner to start creating the rebar = press Enter
- key in “dz-100” and press Enter again.

Then, go to the 3D view with wireframe view mode, move the stud by -10 on axis Z to avoid
overlapping with the steel plate

(Always remember to check your current workplane before using the linear move command).

Move by Distance

Options  Mowve With

Reset

Mowve |  Close

Select Distance

11. Go back to Section Elevation View, hold Shift + left, click on joist to access the Default Joist
Setting, and set Profile name: D20. Then, left-click on the reference point at the left top corner
to start creating the rebar = press Enter - key in “dz-5” and press Enter again.

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’



2 rRoTA page 62

Default Joist Settings
~ || Load Save

Geometry  General Definiions Detailing Definitions  Analys

1. Left click this node. Profile Name  |D21]
2. Press "Enter".
3. Key in "dz-5" & press "Enter".

C=
I

12. Go to 3D view with wireframe view mode, select and right-click the created circle to move it to
the end of the stud.

& Set View Properties

?a Inquire
=& Save Bitmap to Clipboard
Select Origin of Interest ~ F9

Show Selected
Hide Selected
Show Only Selected
Show All
Select Assembly
T Measure Distance Alt+R
, Measure Angle
#” Copy
Copy Special
Move

13. Hold Shift + left click on Weld command (in Steel tab) to access the Default Weld Settings and
set:

o Weld Type: All-Around,
e Size:1
Click OK after setting. Start creating weld by Left-clicking on the command:
e Create Weld between Steel Plate and the stud:
i. Click on the weld path that should be welded.
ii. Click on the steel plate (which is the larger object)

e Repeat the same steps to create a weld between the stud and the stud end.
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Default Weld Settings X

~ || Load Save Save As Delete
Settings

Above Line

Size | 1

Type b1 ~
‘Weld Type Edge ~ | Operation Location VWarkshog ~
Edge
Root Eront 8 Back Stitch \weld /| Annotate
Reterence Text
(o] Apply Setas Default Cancel

14. Once the welding is finished, copy the stud, including the welding, and paste the rest of the
reference points.

15. Repeat the welding steps for the beam to the steel plate.
You may right-click the RC column = Hide Selected if necessary.

Right-click on the background = Show All to reveal all the hidden item(s).

Steel Beam to Steel Column Manual Connection

A steel beam to steel column connection can be done using a manual steel plate connection in
ProtaSteel. The steps are somewhat similar to Steel Beam to Reinforced Column Manual Connection.

1. Using the Boundary Cut command, we can cut off excessive steel beams (in the Edit tab).

(Object Cut command is unsuitable because the cutting member can only cut the overlapping volume.)
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I, First, select Member to Cut.
. Second, select the Cutting Member.

lll.  Select “No” from the pop-out warning to remain the
Cutting Member.

2. Repeat steps 2 to 5 in Steel Beam to Reinforced Column Manual
Connection.

3. Hold Shift +left click on the plate, set:

. Position In Depth: “Front”
(Alternatively, it can be adjusted via hotkey CTRL+W in
modelling view)

1. Thickness (t): 10

4. Use the Object Cut command to cut the beam and the plate—select beam = Select the plate
- select “No” in the warning.

5. Now, we can create bolt using Bolt command (in Steel tab), hold Shift + left click to preset the
default setting:

I.  InSettings 1 tab = Diameter: 12
1. In Positions = Grid:
» X Positions =30 60

> Y Positions =-30-140

Default Bolt Group Settings Default Bolt Group Settings
~ | Load Save ! || Load
Sefings 1| Settings 2 Seftings 3 Positions  Selected BoltC Seffings 1 Sefings 2 Setfings 3 :
Array Circular
» Positions: 3060
Bolt Assembl |B'B—BOLT || | |
¥ Sample X Position
Diameter |12| Y Positions: |—3IJ -140
Thread In katerial ~ Samnlaty
e  (Click OK once finished.
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6. Left-click to use the Bolt command.

I. Select plate and column. Then, right-click once to enter the next stage.

1. Select the top left corner of the steel plate and then select the top right corner of the
steel plate.

Left click to select Bolt Group
1) select plate

2) select column

Click right click here.

3) select top left corner of the
plate

4) select top right corner of the
plate

7. Lastly, weld the beam and the plate using the Weld command as covered previously.
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Connection Design Reports
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ProtaSteel can create design check reports for the following connections in accordance to EuroCode3,

AISC (LRFD), AISC (ASD), BS5950:

e Beam to Beam Connections: End Plate, Stiffened End Plate, Fin Plate

e Beam to Column Connections: End Plate, Stiffened End Plate, Fin Plate

e Beam to Beam End Plate Connection

e Haunch Connection

e Direct Welding Connection

e Simple Base Plate Connection

e Flange Plate Moment Connection

e Extended End Plate Connection

e Bolted Gusset Plate Connection

e Corner Bolted Gusset Plate Connection
e Welded Gusset Plate Connection

e Corner Welded Gusset Plate Connection
e Apex Haunch Connection

e Splice Connection

e Base Plate Connection

ProtaSteel can’t create any calculation check for the below connection types.

e Faves Beam Connection

e Fitting Connection

e Sag Rod Connection

e Purlin and Girt Connection

e Welded Pipe Connection

e Apex Truss Gusset Connection

e Truss End Plate with Gusset Plate
e Batten Plate Connection

e Stiffened Web Opening

e  Multiple Stiffened Web Opening
e Beam to Wall Connection

e Embedded Plate Connection

e Manual Connections
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Reports include both geometric checks and capacity checks. In addition, intermediate calculations,
references to the appropriate clauses of the design code, and corresponding equations are displayed
for easy checking.

" Bolt Checks
ProtaSteeIP‘ . 21-Feh 1 Using elastic bolt analysls for plate
’ Fin Plate £C3 25524 P Boit £ 800,00 WP
I Fiate | 355,00 MPa
Fx E52N
T P 1908130 Fy J50RN
M 058 kNm
Hartsontol farce f, {1,1) B0 RN
Vertical force f, (1,1} 1T5EN
Resuirant faree £ (1,1} EOTEN
| J Harlzantal faee f, (2,1) 13.786N
“ Vertical force f, (2,1} 1T5EN
- Resuitant farce £ {2,1) 13.396N
“
Single balt shear resistance TTABKN 2 Wige 13.35kN 576 EC3 18734
Bait f BI000MFT e fun A
- Fong =
p— : i
e Pour 125 Yuz
Balt bearing reskstance 11430KN 2 Visw 13.35 kN B53 EC31ETEA
Bait diomater 1&0mm
Connection Info Thic "‘ e Admm "
Connection Mame = Fin Plate Bait fu. soepomMPa kyay f,d ¢
Mmacio iD= 6825 Poi L35 hgd &
Design Standard = EC3 i 255,00 MPa fuaz
supported Beam £ E10.00 MFa
sark= B cocton - e Grade= 5355 3alt group extermal tearing {top) BAEBKN = Wig 175 kN 4837 EC3 18734
he 2600mm Rectrad.« 130mm fy= 3550007 Singie boit tearing resistance B4ER KN
b 1750 mm Areas 5589.1mmt fus 51000 W78
= 1lamm Span= 4.71m tw= 7Omm Balt grovp extermal bearing right] BAERKN 2 Vis 13.28kN B35 EC31ETEA
e bolt tearing resistance BLEE kN

The reports can be created on-demand in rich text format (RTF). Design Status colors can be seen on
model view before report creation. To show the utilization ratio of the connection visually:

e (o to view (tab) = Color Coding = Connection Design Ratio Coloring

The connection will color coded : = Not checked/designed; Green = Pass; Red = Fail.

' o o To check the connection & generate the report :
] \S

e Select the connection by any of these methods :

e Select the connection macro sign >

e Select any component of the connection (eg. a plate or
a bot) = then press “M”

e Left click and drag a window enclosing the entire
connection

e Hold down CTRL to multiple select

e Right-Click > Connection Design Reports (or Go to Drawings & Report (tab) > Create) = Select
the desired report :

e Show Connection Report = Show connection report of selected macro(s)
e Default Connection Report = Create connection report according to project preference

e EC3/BS5950/ AISC_LFRD /AISC_ASD Connection Report = Create connection report for the
selected code
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Connection Design Summary Table

Page - 68

The connection design summary table presents details about selected connection macros. The summary
table shows the “Frame Id”, profile types of macro dependents, connection type, the capacity ratio of
connection, design status according to capacity ratio, and whether a design report is created.

e Select one or more connection macro

e |f no macrois selected, the table will show all supported macros in the model

e Goto Drawings & Reports (tab) = Design Summary

A

> ® B

Frome Profiles Macro IDs C"’ﬁ“’“ Capacity Desion Design Report
[zl_ﬁﬁ[‘}ffgi ety 10909 0.041 < 1 Pass

aoxa | IPE160-La0Xs 8894 0.011 <1 Pass

1C3-1B1 | HE200A - IPE240 10647 copiauneh, 1521 Fail
1B9-1B10S | IPE160 - IPE100 8037 on Plate 1521 Fail

1&;&;&? IPE240 - L80X8 9308 0.012< 1 Pass

e IPE240 - L80X8 8544 0.012<1 Pass

15_79}[‘},1;1 IPE240 - LBOX8 9286 0.012<1 Pass

1['3@5,1{;1 IPE240 - LBOX8 8647 0.012 < 1 Pass

1[?5&5,153 IPE160 - LBOX8 8975 0.009 < 1 Pass

eoxa. | IPE240-180x3 8514 0.009 < 1 Pass

axa, | IPE160-La0Xs 8941 0.018 < 1 Pass

1&%}5;&‘]3 IPE240 - LBOX8 8617 0.018 < 1 Pass .

The top icons from left to right :

Update = Refreshes the table

Open Report = Open the selected design report

Show in Model = Locate & zoom in the selected macro in the model view. Double-clicking
on any row will also perform the same function.

Create Report = Create the connection design report of the selected macro. Hold down
CTRL key to multiple select.

If the connection fails, change the macro properties. If the connection parameters are sufficient, the

design status color will be green.
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Collision / Clash Checks

Before creating general arrangement drawings, a clash check must be performed for all elements. The
clash check will highlight the elements that are clashing or overlapping :

e Select all or some elements of the model
e GotoTools (tab) = Clash Check
e Alternatively, right-click on the model screen and pick Clash Check

As a result, the clashing elements will be left selected (in red). Generally, a collision occurs when two or
more elements overlap each other. It usually occurs when connections are not made yet. For example,
before the haunch connection was made, the beam end flange & web plate overlapped into the column
(as shown below).

17 Select Origin of Interest  F9

@ Show Only Selecteds
@ Show Al

©E Measure Distance ~ Alt=R
Measure Angle

Copy

Copy Special
Move

Move Special
Match Elements.

e
Create Views

IntelliConnect
Create Drawings
Draw Type

') Selection

% Frames

If a Clash Check is performed by selecting both the elements, they will remain selected after the check.

Audit Model

Before creating the detail drawings, it is crucial to determine errors and inconsistencies in the model.
This function will perform several model tests, such as duplicate points :

e GotoTools (tab) 2 Audit Model

e Select the checks desired 2 Run Test

udit Detailing (0 object(s) failed... = +| Show Warnings
Audit Detailing (0 object(s) failed..) ] e Filtering

I:‘ Modified After
I:‘ Madified Before

01-Jan-14 | [12:00:00 At-5
Detailing Tests
26-Aug-21 - 31556 A= Run Test (CTRL + Enter)

Cansistency in hetween objects
Check Geometric Consistency

Consistency in between objects

ObjectList Pelations
Numbering Data

g&ﬁ;g Fix errors Audit Detailing Results Grouped Results /

Bolts Delete Duplicate Paints Testing Cuts: 0 object(s) are checked... ~
Plates |:| Delete Free Points Testing Rebars: 0 object(s) are checked...

Cuts Testing Generic Solids: 0 object(s) are checked...

] Welds Testing Numbering Data: 10 object(s) are checked...

Rebars Testing Profiles: 3 object(s) are checked...

Solid Testing Duplicate, Overlapping or Close Profiles: 3 object(s) are checked...

0 object(s) failed...
0 object(s) raised warning...

Select Elements Reported as ERROR Save Report
Select ALL Reported Elements

Select Elements Reported as WARNING Close

You can select the object(s) specified in the result report and automatically navigate it in the model.
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Detailing Item Manager

The Detailing Iltem Manager creates and manages detail items such as the connections.
We can use this function to create exploded drawings of the connection with different
views and detail information such as dimensions, location of bolts, welds, etc.

Page - 70

\s

Detailing
ltem Manager

e Zoom into the connection that we have created at
Grid C
e (lick & drag a window to select all components of
the connections, including all the plate, bolts &
welds

e Pick Detailing Item Manager in Steel (tab)

The Detail ltem Manager dialog will appear.

Detail Item Manager: ID[0]
ot ]

Offset. 100

Don't Use View MNarmes in Drawings &

Main JaintId:

Select Ohjects I Change Box Change Coor Filter Biox

7 Add Remaove Rename Close Clear Connection Names

Right

Restare Filter

Set Connection Names

In the Detail ltem Manager :

Type the name “Conl” at the bottom

Pick Add = Con 1 will be added

Pick Select Objects

Select the beam, the column & the 2 braces
Right-click

The moment we do so, a “3D detail box” appears around the connection in the 3D view (as shown
below)
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Detail ltem Manager: ID[21455]

ok il !
N

% Depth

100
e Cmm—
Don'tUse View Names in Drawings A
Main Jaint |l g

Select Objects | Change Box Change Coor Filter Box Restore Filter

Rename Close Clear Connection Names Set Connection Names

This box controls the various directional views we want to show in the drawings. The view is shown in 3
colors, red, blue, and green. Each color has a front & back view. Hence there is a total of 6 possible
views. The view names can be changed — so if the top of the connection is not the actual top, change

the name manually.

Close to save & exit the dialog

For this connection, pick Front & Right only, as it’s the best viewing direction for this connection.

Pick Filter Box to show only the connection elements (Restore Filter will restore all elements)

Click on the “+” icon to add a 3D view of the connection (if desired)

Repeat the same steps for the Splice Connection at the corner column at GL D/3

For practice purposes, we can similarly insert a connection box on the connections we have previously

created in Story 1. The summary of steps are :

Zoom into connection

Add the connection name

Close the dialog

Pick Detail ltem Manager in Steel (tab)

Tick the desired view direction box

Open the view that is most suitable to insert the connection, try Storey 1 view

Click & drag a window to select all components of the connections, including all the plates &

Click Select Objects & pick all the members of the connection

We have completed the connections and are now ready to generate the drawings.

ProtaStructure’
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Preparing Engineering Drawings

ProtaSteel has a powerful tool to prepare engineering drawings — it's simply called the “Drawing
module”. The drawings are based on the views prepared in the modelling module. The steps are
summarized as below :

e (Create the desired Views in the main modelling view.

e Ensure the orientation of the view you want to use in the drawing is correct, as the drawing
module will automatically use the latest views.

e Double-click on Axis 3 view = Press F4 to reset the view to default

e Double-click on Storey 1 view > Press F4 to reset the view to default

e Create any detail views such as connection details using Detailing Item Manager

e Start the Drawing module by going to Drawings & Reports ribbon = click Drawings 4
e Alternatively double-clicking Drawings in the Model Explorer panel (Ctrl + D)
Drawing Module
H @ s Drawings = = [m| b4
Edit Dimension Annotation Tools
|*= Import ~ Mave v 7 e
Update Al C C ard o S o £ - .
%3 Update Modified 1™ BXPOt ~ S R - o ¥
Drawings Copy & Move Selection View Text & Shapes Import Defaults ~
Explorer I X
52 Drawings Manager (Fs) To Create, Open, or Manage Drawings:
V| M@”d;g”s‘:“rfws Press F6 or Double Click on Drawings Manager in the Explorer
= &l (Storey F)
....... & (Storey 1)
[&] (Storey 2)
[&] Axis3

23 Opened Drawings
[Ea Model View (Ctrl+D)

0

In the Drawings Module, the same views that were shown in the primary model will be duplicated under
the Explorer » Modelling Views :

e 3D view — 3D view of the model

e Storey F — foundation plan view (STOO in ProtaStructure)
e Storey 1 —Storey 1 plan view as defined in ProtaStructure
e Storey 2 —Storey 2 plan view as defined in ProtaStructure
e Axis 3 — New view along Axis 3

e Axis A— New view along Axis A

If you do not have the same views, please close the drawing module to return to the main model &
create the view as outlined in previous sections.

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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Creating Drawings via Drawing Manager

e Double-click on Drawing Manager (or F6)
The Drawing Manager is where you can start a new drawing.

The View Manager allows you to manage the drawings:

e Create a new drawing using Create Drawing = Create New Drawing Dialog will appear.

e Name the drawing Storey 1, Set Paper Size to A1 - click OK.

Mame Starey 1 |

Paper Size A1 ~ b arging
Left Right
Orientation Landscape w
. Top Bottom
Drawing Type | Steel Azzembly w
-3 -3
Mote | |

Cancel Reset

e Storey 1 drawing should be automatically opened.

e If not, select Storey 1 = Open Drawing

& Drawings Manager = O X
= H— o = |

Name Dimensions Type o Stetle  Need lssued  Flag  Drawn Marks lpen Diemee)

[0 Storey1 Al Landscape NatAssigned Opened N Close Drawing(s)

e Close the Drawing Manager and the blank drawing will be shown as below.
e Right-click on Storey 1 located at the explorer panel> Create Viewport

The viewport will be inserted into the drawing.

@ Storeyl - (Paper : -103,90.75 mm.)

Explorer

B3 Drawings Manager (F6)

v -[B Modeling Views
e e S Viewport Border

-] (Storay 1)
-..[®] (Storey 2) Create Viewport
& Axis3 T
~ [ Opened Drawings
[7d storey1

@1 Model View (Ctrl+D)
N I =il Drawing Border

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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The outermost brown line is the Drawing Border (Al size). The size & other settings of the drawing can

be changed by :

Page - 74

e Double-click on any space within the drawing border to access the Drawing Properties

Drawing Properties
ID:1

Drawing Name

|Storey 1
Fones

Margins {mm} Left Right

Created By
Creation Date

Approved By

Bottom

Top

Type Stesl Assembly o Farmwark State
@ Nammal

faceesie Orientation

il ~ CPorait LastFrinted On

DiawPapsBoundary @ Landscape Drawing Stete
(e () OManual ®) Normal

Macros
Note

0 21-Apr-21 120651 Pt

X

Indlex Date Description  Sign Custom #1 Custom #2 Custom #3

following can be changed:

e Drawing Name

e Print Area & Margin

e Paper Size & Orientation

e Created, Approve by, Approved Date

e Document State : Normal / Frozen

Documents Properties will appear where the

The inner dotted blue line is the Viewport border which is directly linked to the view :

e Place the mouse cursor at the lower-right corner > the cursor will change to resize g

e (lick & drag to resize & ensure all the elements are visible

e Place the mouse cursor at the boundary line = click & drag to move the position of the region

e Double-click any place within the viewport to access the Viewport Properties

e The region has been renamed viewport in the current release

Viewport Property Editor
~ || Load Save Save Az

Gereral  Label Seftings  Detaiing  Filtering  Presets

Unique D : 2
Mame |5tore‘,.- 1 Plan |
Modeling Wiew D [e18

Modeling Yiew Mame | (Storey 1)

Boundary 5555/ 218357,289 786 |
Scale a0 | |
Dffset(<,Y]  |-10000 |[ 12500 |
Rotations |U | |D | |D |

Use bolt faces for Hidden Line Remowval [HLR]
| Fiw wiewport center during resize
Do not delete viewport

Drave Mode: || iHi

Collapsible
Fit P

Fit Settings Min. Collapse Size

Collapze i # Collapze in v
4

Apply Set az Default

Min. None Collapse Area Size |0
Re-mpart All
Statoffset 5 | Gap |2
Import (Update] | [All distances are in mm.)

Viewport Proper Editor dialog will appear. In the General
tab, the following can be changed :

Name of the region

Scale

Offset (X Y): Coordinates of view
Rotation: States the rotation angle

Drawing Mode: Line/All Visible/Hidden Line/Full
Dashed

Change the Name to Storey 1 Plan
Change say Scale to 30
Change Draw Mode to Hidden Line = Apply

The drawing will be updated to scale & hidden line.

Pick Fit to autofit all the elements & the new title

ProtaStructure’

ProtaSteel’
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Viewport Property Editor o
°

~ || Load Save Save Az Delete

General | Label Settings| Detaiing  Filtering  Pressts

Label Position

Difset to Right [mm.] D
Offset ta Down [mm.] l:l

| Locate Outside

Mo lakel

(<]

Mame Text Settings

Go to Label Settings tab

The Label Settings dialog allow you to change :

= Label Position
= Offsets

= Name & Scale Text Settings

_ e  Pick Locate Outside so the label will be place
Fart |Ca||br| | P | Change | § . .
wirite Mame And Scale In One Line OUtSIde the rEglon border
Scale Text Settings . e  Tick Write next to Name & Scale Text Settings
Fant Avrial Ch. . .
o | [ [Ctarae ] e  Pick Change under Name Text Settings
‘Viewpm bl e Change Name Text Height to 10mm = OK
e  Change Scale Text Height to 10mm = OK = Apply
Notice that the name and scale appear larger in the
Ok Apply Set az Default Cancel d raWing'
B x e Goto Filtering tab
Y|| Load || Save || Savehs [| Dekte e The options here controls what is shown in the
General Label Settings  Detailing Prezets drawing :
ww [ ooy [T ] =  Up (+) & Down (-) filters objects in & out of the
paper
binirnumm 3 b airnunm <
N E— _ N =  Min X & Max X filters objects in the X plan
Iinirnum v l:l b airnum v I:I direction
Reset 2 Limits | |y, Down Method | Partial v =  Min Y & Max Y filters objects in the Y plan
Alzo cut non-formwork objects using Up & Down d irection
Show coordinate spstem on screen
N e  Up-Down Method :
ilker Point Mode
O 2D Last Posiion =  Partial : Any element that exists partially within
O 2D Definition Postion the above extents will be shown
@3> *=  Full : Only elements that exist fully within the
Giid Fiter Made above extents will be shown
(® Unlimited Up/Down . . . . .
O Pass Alwaps e  Filtering Settings — expose more filter options
O Normal e  Change Up(+) to +500 & Down (-) to -500 —>
Apply - Girts disappears as they are placed
slightly above the floor level
Apply Set as Default Cancel ° P|Ck Fllter Settings
ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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e pens * Filter Options enable advance filtering :
~ Save | Save As | Delete

General | Object Types Adta | Sofd | Mocro = General : Steel, Concrete, Unique ID, etc
Profile IDs ‘
Frofile = QObject types : Grid, Profile, Joint, Weld, etc
%ar';rées IPTUT“‘ES ~ | Beam Grou| Column ~

LPr B .

U Profile Hebrace »  Profile : Columns, Beams, Brace, etc

Round Tube Profiles V.Brace

Square Tube Profile Girt

T i I Purlin = Plate : Plate IDs, Types & Usage
Material ST37 ~ atar:;gé;”

o Column Lacing =  Solid & Macro

5735 (L:r:;e Girder

5275 adder

535 Tries oo Coar e  Goto Profile tab

£205 ;russ\ﬂ;”‘eh L

Fone 4 ower Main Lea e

Frefix Start No Actual Number PY Tle Column' Beam’ H. Brace
Part
Assemb . .
Structural Profi Show All ~ L] P|Ck OK tO EXIt
Cox 7 concel Clear Filter Values This ensures that only column, beam, and horizontal
elements are shown.

Visibility and Selectability in Drawing Module

Visibility settings allow the user to show and hide elements that wish to hide/show in the drawings. In
contrast, Selectability settings allow the user to lock the elements and prevent them from miss-click or

accidental

You may e

ly deleting them.

asily access it in the Edit tab go to View - Click on Visibility

<$

Visibility

=z ®

SIS
Section Detail Draw
W View Mode™
View

By default, all elements will be ticked. If the selected element is unticked and press “OK”, the effect
will immediately apply to the selected element in the drawing.

Drawing Options x Drawing Options x
SE\E-:lablth Snaps \/\awblhly Snaps
v Llosd || Save | SaveAs | Delete | . v Lload || Save || SaveAs | Delete
| Viewports | Constuction Polygons | Generic Solids | Viewports /| Constuction Polygons | Generic Solids
/| Frames /| Constuction Rectangles | Deetail Yigws /| Frames /| Constuction Rectangles | Detail Yigws
| Joints /| Constction Tables /| DvF Bymbals | Joints /| Constction Tables /| DvF Bymbals
/| Plates /| Constuction Ellipses | Slope Dimensions /| Plates /| Constuction Ellipses | Slope Dimensions
+| Bolts V| Construction Arcs +| Bolts V| Construction Arcs
/| Modeling Solids /| Containers /| Modeling Solids /| Containers
| Drawing Salids | Clouds | Drawing Salids | Clouds
| welds | Dimensions | welds | Dimensions
| Grids | Padial Dimensions | Grids /| Padial Dimensions
/| Rebars /| Circular Dimensions /| Rebars /| Circular Dimensions
| Farmworks | Section Symhals | Farmworks | Section Symhals
| cuts | Level Indicators | cuts /| Level Indicators
| Snap Points V| Texts | Snap Points | Texts
/| Construction Lines /| Weld Annotatians /| Constiuction Lines /| Weld Annotetians
| Construction zigZags | Pebar Annotations Handles | Construction zigZags | Pebar Annotations
oK. Apply Cancel oK. Apply Cancel

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"



2 rRoTA

Grid Level Visibility

Now, we will insert the 3D view into the

drawing.

e Right-click on 3D View = Create Viewport

= Modehr:g VIEWSJ

(Storey F)

In the 3D view, the grids appear in each

Create Viewport

storey.

To show the grids at the storey 0 only,

e Double click on any Grid - Grid

Properties Editor will appear.

e Untick 1. Level and 2. Level under Grid Level Visibility = Click OK.

Grid Property Editor

Unigue ID: 903 Modeling 1D 1005

|| Load Sawve Save As Delete

Grid Lewvel Wisibility

Extension Length (mm) 30 v 0 Lewvel
- 1. Level
Text Style Circle e B el

Grid Captions :
Haxis side 1 Y axis side 1

Haxis side 2 Y axis side 2

e The 3D view will now look clean.

ProtaStructure’

ProtaSteel

2 axis side 1
2 axis side 2

ProtaDetails’ ProtaBIM’
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Profile Annotation

We now add steel profile annotation, i.e., show the member sizes. Firstly, we should select the members
we want to annotate. To select the members easily, we can control what elements are selectable:

Selectability

e Go to Edit (top menu) Click on the Selectability icon
dialog.

to access the Drawing Options

Drawing Options e  Untick Viewport = OK
Wisibility Selectabilty  Snaps

This prevents you from selecting the viewport border.

The same options are available in Visibility tab which controls what
is shown in the drawing.

| Joints

e Inthe drawing, left-click & drag a box around all the steel members to select them

e C(Click at the bottom arrow of Profile Annotation icon = Click Annotation Settings

Edit Dimension Annotation
ABC ABC ABC % ABC
Profiles | Plates Cuts Bolts Welds
Frame Annotation Settings x .
’ T The settings here control how steel

M2

Clear All

members are annotated (labelled) :

1D
Profile Name

\Actual Part No

Single Profile Name

\Actual Assembly No

lActual Assembly No (b/h)
Actual Assembly Ne (b/h)em
\Actual Assembly No (H=)
Actual Assembly No (H=)em
Main Actual Part No

Material
Name
Special ID

M22
M33
Critical Ratio
Stress Ratio

Design Restriction
Critical Design Combo
N

Lamda Ratio

Shear Ratio

Deflection Ratio

Design Ratio=x+y+z=DR
User Defined 1

User Defined 2

/ Protastructure Label

The various type of annotations is listed in
the table

Clear

Profile Mame
Material
ProtaStructure Late!

Clear

Clear

Clear

Lo ]

Apply

Clear

Apply & Create Annotations

Cancel

Clear

Annotation Settings

e C(lick & drag any annotation name into
the box which also defines the position
of the annotation

e C(lick and drag Profile Name, Material &
ProtaStructure Label in the box

e C(lick Annotation Settings to view or
change the text settings :

= Font type & size

ProtaStructure’

ProtaSteel’

= Format or style of the annotations
e Change the Text Height to 7 mm

e Click Apply & Create Annotations
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The annotations are added next to steel members, as shown below.

UB 250X 125X2E S355 1B6

UB 200X150X30 S355 1B9 |

UB 200X150X30 S355 1B8

o
—
[Ts]
w0
el
w
w0
o
>
2]
o
—
x
o
n
o
m
=)

ProtaStructure Label is ProtaStructure member labels such as 1B1, 1C1
e The annotation position can be moved by left click & drag
e Annotations can be deleted using the Delete key

e Annotation text size, font height, etc. can be changed by selecting them = ENTER = Annotation
Text Property Editor

Dimension

i

Horizontal Vertical Aligned

Dimension tools can be used to insert dimensions in the drawing.

e Zoom in the top around primary beam
along axis D

e C(Click Horizontal Dimension —

e Left-click on the 1% point & then the 2™
point between the points to be
dimensioned.

e Move the mouse cursor away to the right

Notice the dimension is shown dynamically.

e Left-click on the 3™ point & then the 4™ point

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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Move the mouse cursor to the exact position where you want the text to be placed

Right-click to confirm & create the dimensions

The dimensions will be created as shown below.

I
uB 250X125X2§ S355 1B6

Page - 80

Creating Connection Detail

Let us now create a new connection drawing for the connection we created along Grid 3.

Double-click on Drawings Manager (or F6)

Pick Create Drawing = Create Drawing Dialog will appear

Create New Drawing

Marme Conmection Az 3

Paper Size &1

Orientation Landscape

Drawing Tupe | Steel Connection D etail

e

L3

e

Mote |

Cancel

I arging:
Left Right

Top Bottom

Feset

Name it “Connection Axis 3”

Change the Paper Size to A1 - Orientation = Landscape

Pick Drawing Type = Steel Connection Detail

Pick OK = The drawing will be created & automatically opened

Close the Drawing Manager dialog (Pick YES if prompted to save)

The drawing “Connection Axis 3” will be opened and brought to focus. The drawing is empty & we will
insert the required view into the drawing.

Right-click on Axis 3 View = Create Viewport

ProtaStructure’

ProtaSteel
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w - Modeling Views
3D Wiew
[Starey F]
[Starep 1]
[Starey 2]
iz 3

W

I Model Wiew [Cti+D)

The viewport will be inserted into the drawing.

® Connection Axis 3 - (Paper: 596.287,214.76 mm.)

As explained previously, if it is not positioned correctly, you can click and drag the blue view port border
to reposition it. If you cannot select the blue border :

e Click on the Selectability icon . atthe top menu to access the Drawing Options dialog

Drawing Options

Vishity Selectabilty  Gnaps e Tick Viewport = OK

e Click & drag the viewport into the Drawing Sheet

Mimvports

e Double-click anywhere in the Connection Detail Drawing viewport to call out Viewport Property
Editor.

e In this dialog, you can set the details of the connection drawing, such as the scale and
Annotation

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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Viewport Property Editor

~ || Load Save Save As

General Lakel Setings  Detailing  Fitering  Presets

Page - 82

Delete

peg [0 Dawn (9

Fesetx Limits | Up-Down Method Full

~ (]

Also cut non-formwoark objects using Up & Down

Show coordinate systermn on screen

Double-click on the region to access the Viewport
Property Editor

Scale can be change but let’s leave it as default
Go Filtering tab = change Up = 500 & Down = -500
Up-Down Method = change to Full

OK to close the dialog

The drawing will show only members that are fully
within the Up & Down extents.

Notice there is a circle around the connection — this is directly linked to the connection box created in
the main model, which will be used to create the detail connection drawings.

To create this connection drawing :

e Goto Tools (top menu) = locate Connection Detail Drawings icon w

~

& h

o Shift + Left click this icon to call out the settings of Connection Detail Drawing Macro.

Connection Detail Drawing Macro

Gereral  Annotation & Display Settings

Profile Drawing Preset

| Diraw Boxes
| Use View Baged Annotations
Annotate General Arangement Diawing
Arnotate Dul of Plane Profiles in General Anrangement Drawing

Viewport Label Fant | wirite Viewpart Label

Scale Label Font | Mwfiite Beale Label
Section Label Set v Samplesd, B, C...
Macra Pressts
Load Save Save b Delete

Apoly Get

Cancel

Connection Detail Drawing Macro »
General  Annotation & Display Settings
Annotate

Frame Settings v Annotation Field and Text Dizplay Get Frame Defaults
Plate Settings v Apnatation Fiedd and Text Display Get Plate Defaults

Balt Settings v Annotation Field and Test Display Get Bolt Defaults

‘weld Settings Annotation Field and Text Display Getweld Defauls
Generic Solid Settings Annotation Field and Test Display Get Solid Defaults

Gt &l Defaults
Apply Get Cancel

o Under Annotation & Display Settings, review Annotation, Field, and Text & Display

e |[f there are any changes, click OK to save & exit.

e Click on Connection Detail Drawing Macro icon N7

The Connection Detail will be inserted into the drawing as shown below.

ProtaStructure’
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UB 250X125X25

Detail 'Front’
Scale: 1/25

Further customization of the connection detail can be done.

Viewport Preperty Editor

~ || Load Save

Bolt Group [mport Style

Save As

General Label Settings | Detailing | Fikeing  Presets

Page - 83

Delete

Double-click in

the detalil

region of the

connection to access the Viewport Property

Editor

Under Detailing tab, you can change :

= Bolt Import Style

= Bolt Drawing Style

Try the various options & click Apply

O all (O Balts Orly (® Holes Orily
Balt Drawing Style Line w ||
Viewport Property Editor %

~ || Load Save Save bz Delete

General Label Settings  Detailing | Filtering| Presets

w0 | Downt  [378 |

Minimum >4 [-343.659 | Masimum . [343.853 |

Miimum ¢ [-398.638 | Masimumy  [338638 |

Fleset 5 Lnits | 1 jp Down Method | Partial v
Also eut nerdarmwark obiects using Up & Down
Show coordinate system on soreen

Fiter Point Mods

(0 2D Last Position

(0 2D Defirition Pasition

@

Grid Fiter Mode

@® Uniimited Up/Down

O Pass Always

O Mormal

Filter Sefings
oK Set as Defaut Cancel

General |Object Types| Profile Plate  Solid

Object Types Grid
~ Profile
Dimension
Joint
Floor
Construction Line
Construction Circle
=~ Rebar
Cut
=~ Plate

. § §
ernal Drawing Objects

Solid

oK Cancel

alate Solid  Macro

~ Column ~
| Beam
H.Brace
| V.Brace
Gt
Purlin
Truss
Stringer
Hand Rail
Column Lacing
Crane Girder
Ladder
Truss Top Chord
Truss Bottom Chord
Truss Web
Tower Main Leg
Tower Diagonal
Zero Member

e Go to Filtering tab = Pick Filter Settings

e Go to Profile & check Columns, Beams & V. Brace

e Go to Object Types = Untick Weld

e Click Apply = OK

This will only show relevant members of the connection. The welds shown in thicker lines will be hidden,
assuming you may want to show welding in another drawing.
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ABC ABC_ ABC ABC

Plate, Bolts & Weld Annotation Tools < B L

The bolts, plates, and welds are automatically annotated in the above example. If you wish, you can
manually do so by using the plate, bolts & weld annotation tools under Annotation ribbon

e Hold down CTRL key = select all the annotations of the “Front” detail = delete them

e C(lick & drag a window (right to left) to select bolts & plates to be annotated (does not matter if

other objects are selected)

ABC
ao

Bolt Annotation Settings x = -

~ || Load Save Save As Delete

Bolts

e Click on the arrow below of Bolt Annotation - to
E access the Annotation Settings

Diameter
Length
Diameter & Length

e Pick Clear to remove existing settings
Assembly
Haole

e C(lick & Drag Count, Diameter & Material to the
et bottom Fields

Court Clear
Diarneter
Material

e Pick Annotation Settings to view/change font type,
color, etc 2 OK

Horizontal Wertical

o s s e Pick “Apply & Create Annotations”
Plate Annotation Settings x —
v || Loasd || Save || Seveds || Delete <P
. . Plates
. S e Click on the arrow below of Plate Annotation = to
Fite Name (Pt ey Deer Detned access the Annotation Settings
Symhol Actual Assembly Mo / Thickness
ictth Actual Assembly Mo / Thickness (om)
Height Actual Assembly Mo / Metadats A L .
phckaces PLThickness e Pick Clear to remove existing settings
|Actual Assembly No
Actual Part No
e e Click & Drag PL Thickness, & Material to the bottom
Fields .
[mﬁss i Fields
e Pick Annotation Settings to view/change font type,
Horizortal Vertical Float Format Color’ etC 9 OK
52 Fla
oK Appiy Apply & Create Annotations Cancel Aratation Settirgs ° P|Ck uAppIy & Create Annotationsu

You should get details similar to the figure shown below (depending on your preference).

The drawing can be further improved by :

Il
2M20(Class 8.8) [
[

IPL 8 $355 ) ) )
e Go to Viewport Properties Editor and change
the Scale
PL 8 S355 ©
- %} ﬁ e Change Offset (X)Y) to reposition the
2M20(Class 8.8) i ‘J ® connection
S '4._—‘ o
PL 8 S355 N - e Delete any annotations that you think is not
- required
- 2M20(Class 8.8) e Click & drag the annotation to reposition it
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Numbering Objects

Before parts and assembly views & drawings can be created, the objects must be numbered. By default,
all objects are included in the same numbering group. To assign objects to different groups:

e Double-click on a steel member in the ProtaSteel t0  [fone 0 25 prowsiocore o 531

X
Open the PrOfI|e dla|0g ~ | Load Save Save b Delete
Geomety General Definitions  Detailing Definitions  analpsis  Analpsis 2
e Inthe Detailing Definitions tab, input Drawing Group Paent 1D Eclude From Detaling
num be r Numbering
Drawing Group l:l Forced to be main part
. . Prefix Start Number  Actual Mumber Last Humbering
This feature was developed to number the different parts of b I @ P—
the structure separately. sty B ([ [ | meeanzna

Adjustment / Conneclions

The Prefix & Start Number can be specified for each group of Shear Capaciy Rato el Capaciy Fats
(0] bJ e CtS . Behave Az Mone

After the numbering process, the actual part and assembly
number will be shown under “Actual Number”.

Drawings

Exclude From Dimengioning Do Mot Annotate

e InModel View, Go to Drawings & Reports (tab)=>
Perform Numbering

ok Apply Set az Default Cancel

The Numbering Options dialog will appear.

MNumbering Options *
Group Do Numbering Unique Mumber Renumber All Reuse Old Number Modified Part MNew Part
1] TES Mot Unique Modified Do Mot Reuse Feep Mumber If Possible Compare to 01d

Apply Close

As the model is continuously revised, the numbering process needs to be repeated. ProtaSteel has
extensive options for renumbering. Numbering Options can also be configured according to the
preferences of the manufacturer. For example, there is an option to force the geometrically identical
part to have the same number.

Do Numbering

e Specifies whether to number the selected group

Unique Number

e Unique: Can be selected for reinforced concrete elements. Objects are given a different number
regardless of their geometric properties (beyond the scope of ProtaSteel)

o Not Unique: Should be used for steel model. Makes numbering by looking at geometry and
material properties.

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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e Spatial Sort: Can be selected for the reinforced concrete model. This option performs
numbering according to the object’s position. The object’s reference point is sorted first by X
and then by Y. Different groups should be made for different levels. Consecutive numbered
column and beam applications can be an example.

Renumber All

e Modified: Number only the modified objects. Ignores objects that have not changed.

e Renumber number all objects.

Reuse Old Numbers

e Reuse: Uses old numbers.

o Do Not Reuse: Don’t use old numbers. After the changes, there may be no elements belonging
to a number. Specifies whether to use this number for a new element.

Modified Part

Suppose that we have three quantities of P5 and two quantities of P7. The three quantities of P5 have
the same change and become the same as the P7.

o Keep Number If Possible: Retains the numbers if possible after the change. If this setting is used,
the result is still three quantities P5, two P7.

o Compare to Old: Compares and assigns the part-marks from the previous numbering if possible.
If this option is used, the result is five quantities of P7.

o Take New Number: Assigns new part-marks. This option will lead to two P7 and three P8.

New Part

Similar to “Modified Settings”. It only applies to newly created objects. Hence, there is no option to
“Keep the Number If Possible”.

o Compare to Old: Compares and assigns the part-marks from the previous numbering if possible.

o Take New Number: Assigns new part-marks.
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Creation of Parts and Assembly Drawings

If there are no problems after the Audit Model, Clash check, and numbering, the parts and assembly
drawing can be produced.

You can create the part & assembly drawing for the entire model or some objects.
e Select the entire model or objects

e Go to Drawings & Reports (tab) = Create Drawings = Create Assembly Drawing / Create Part
Drawing

The Drawing Module will be launched, and the drawings created.

e In the Drawing Manager - Double-click to open & review the drawing

@ Drawings Manager =

[m] x

Hame Dimensians Type o State Need lsued  Flag  Drawn Marks Open Drawingls]
O s3B186LE00 ADLandscaps  NotAssigned Clossd  F VB4 0VB/3 0VB /2
O esseceo2 ADLandscaps  Notssigned Cosed  F 0GR 0GAZ

O ss156CE003 A0 Landscape  Not Assigned Closed F 0CLADOCLZ Modiy Fields

Close Drawin k=l

Flan____ [0 s A
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Import Titleblock using DXF Import

In ProtaSteel, users can import title blocks and print drawings directly.

e Users can import company standard title block as DXF in Drawing Module by going to Edit =
Import = Import DXF
Edit Dimension Annotation Too

—
Update Current

e |»

Import | Export
€3 Update Modified | =

Update A

-

Drawit Import DXF

e Select the company standard title block DXF directory.

e Paper Anchor and DXF Anchor set to Bottom Right.

Ensure the imported drawing contains only the title block. Block references can not be recognized. In
addition to this, drawing units must be set correctly.

DXF2000 Import x
r

File Name | C: sers\DELL AdminDowrloads A0 testing il block.dhf . I Unit

r Default language: ’m

Layers Elements to be imported

40 v Line v Text
v 3D Face v Dimension ¢
v Poly Line v Elipse g
[v Cicle ¥ Point © Toplef € TopRight
v Arc

(" BottomLeft (& Bottom Right
Settings
Scale I Dxf Anchor
Origin of Import (x.y] 0 o " TopLeft " Top Right
) 0

ez " BottomLeft (& Hol
Number OF Elements N/A

Import | Delete | Clase |

. . . .r . " ” .
e Titleblock annotation can be inserted/modified using the “Text” Function.
Text & Shapes
TEXT

N O %

Text Shapes Cloud DXF
- - M Symbol
Text & Shapes

Text & Shapes allow users to add details to the drawings such as the opening dash line, “to be continued”
line, revision cloud, description, etc.
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e |f you wish to select a point with no object snap, you can hold left ALT to select a free point.
e Please hold the left CTRL before selecting the start point to draw it horizontally.

e |f you wish to draw it vertically, please hold the left SHIFT before selecting the start point.

DXF Export

All the drawings created in ProtaSteel can be exported as DXF format :
e Double-click on Drawing Manager (or F6) = DXF Export
e Under DXF Export = Pick Settings

In the DXF Export Settings, you can choose the layers to be exported, change the Layer Name & Line
Type.

DXF Export Settings X

~ | Load Sawve Save As Delete
Layers  Export Style

standart |ayers

® Boundary Export

™ Regions

M Grids Layer Mame

= !E::mESHldden Lings If wiou givie an existing layer name. ohjects are merged in the first appearing layer!

H Frame Annotations
® Jaints

= é‘D;T;p:nnulatluns L T
® Plate Hidden Lines
® Plate Annotations
™ Bolts

[ Bolt Hidden Lines
¥ Bolt Annotations

™ Solids

M Solid Hidden Lines
M \Welds

B \Weld Annotations
M Construction Objects
M Clouds

™ Foints

® Texs

® Dirnensions

B Dirmension Texts

Feset Layer Names

o Close the DXF Export Settings
e Pick Export > Choose the destination folder - OK

The DXF drawing will be created in the folder selected.
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IFC File Export

ProtaSteel model can be exported as Industry Foundation Classes (IFC) file. IFC is a Building Information
Modeling (BIM) data structure created by BuildingSmart International and is the I1SO 16739: 2013
standard. Most design software implements the IFC File format, including leading Building Information
Model (BIM) platforms like Autodesk Revit, Bentley, and Tekla Structures. Wide-spread usage of the IFC
format facilitates sharing of building information models between various BIM platforms.

e Select objects to be exported as IFC file format.
e |fnoobject is selected, then all objects will be exported.

e In Model View = BIM (tab) = Export IFC File

& IFC Export [ X

ChJsersiprotatDocumentsiProtaDataz02 f0uick_Start_Guide_Steel_Comg

Use ifctdirroredPraofileDet for twin/built-up sections
Export profile section as poksgons

Export Modeling properties

Ohject Types Cancal Export

e Click ‘...” to specify the file name and location to export

e Check the desired export options = Export
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Material Takeoff

ProtaSteel automatically creates material lists of the whole of the steel structure. Material Lists is
located under the Drawing and Reports tab.

Tools  BIM  Help

ving Create Open Part  QOpen Assembly Show Design 4
ngs™ Drawings™ Drawing Drawing Takeoff ™, Report  Summary
Drawings 3 i8] Prepare Material Takeoff )

Part Assembly List

List Assembly Subparts
Prepare Bolt List

Prepare Assembly Bolt List

Prepare Washer List

' CELY

Prepare Slopped Washer List

Gross Profile Material List

Plate List For Built-Ups

There are two methods to prepare for your Material Takeoff and will be presented below:

Method 1

To generate quantity takeoff, say, for the steel members sorted by their sections, please refer to the
following steps:

1. Go to Drawings & Report tab—> Material Takeoff = Prepare Material Takeoff

2. Click OK on the Group Selector Dialog.

3. Two Quantity Takeoff Tables (with different formats) will automatically export as CSV
files: the Summary Report and Quantity Takeoff based on the section length.

4, Repeat steps 1 to 3 for the other Material Lists option to export to the CSV file.
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Drawings & Reports Tools BIM Help

Gd E | NS

3

wing Create Open Part  Open Assembly Material Show Design Create
ngs~ Drawings~  Drawing Drawing Takeoff = Report  Summary h
Drawings I IE)| Prepare Material Takeoff fecks

Part AssemblPrepare Material List
" @ Functionality
List Assembly Prepares materis| list for (selected OR 3} objects.
Prepare Bolt & How to use :
Click the icon, select desired drawing group in the dialog box and
click "OK". Then the newly opened excel file shows the material list

Prer Assel
repare Asse for all profiles, plates, rebars and solids.

Prer v R

repare Wash Select abjects, click the icon, select desired drawing group
in the dialog box and click "OK". Then the newly opened
excel file shows the material list for selected profiles, plates
rebars and solids.

w Hint :
%= CAUTION: If you leave any object selected, material list
will be prepared for only for those selected objects.

Group Selector X

Prepare Slopj

Groups Gross Profile

Plate List For

Cancel

AutoSave < Material_Profile_List f.csv ~

file  Home Insert  Pagelayout  Formulas  Data  Review  View  Help | @share || Dcomments | | file  Home Insert  Pagelayout  Formulas  Data  Review  View  Help

f’\ 5 . gk [Ell Conditional Formatting~ | Ellinsett ~ | 3 v &%+ ’ fm X . s, [ Conditional Formattir
Pastlzel m- BIU- AR =] [ Format as Table ~ FDelete ~ | T~ O~ e meel m- BIU- A =B |\ [ Format as Table ~

- Hiv oA~ | #~ 5 [ Cell styles ~ [HllFormat~ | &~ - Hie & A~ == o < - 7 Cell Styles ~
Clipboard & Font Alignment ] Number £l Styles Cells Editing Ideas Clipboard & Font Alignment ] Number £l Styles

section  Quantity Takeoff based
on the sections length

Section

Summary Report

Material Quantity Length(mi Cover Are Gross Wei Net Weight(kgf)
5355 1 581 1.06 124 124

Material Quantity Length(mi Cover Are Gross Wei Net Weight(kgf)
5355 15812 316 3712 3712

5355 11662 3.74 1123 112.3 5355 2 5265 211 2472 2472
5355 80390 70.69 829.21  829.21 Subtotal 15812 316 3702 3702
5355 70078 40.86  475.29  475.29 5355 2 5831 374 1123 1123
5355 207 5818 5819 Subtotal 11662 374 1123 1123
5355 5572 17052 17052 5355 4 10000 3513 41259 41259
5355 295 753.35  753.35 5355 8 5049 3556 41662  416.62
5355 58.28 1613.55 1613.55 Subtotal 80330  70.69 829.21  829.21
5355 53.6 1629.73 1629.73 5355 8 2005 9.33 1088  108.8
5355 8 1885 878 1023 1023

336.26 7737.65 7737.65 5355 8 1034 485 5608  56.08

5355 8 1819 847  98.68  98.68

5355, a 1500 a5 ___JnFa___anee

Method 2

Method 2 generates a more detailed quantity takeoff with choices of categories to be included in the
table. Please refer to the following steps:

e Go to Drawings & Reports = Material Takeoff = Gross Profile Material List
e Select corresponding format and units and click Execute Report.

e C(lick Save to export generated report as a CSV file.
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Drawings & Reports  Tools  BIM  Help | Gross Profile Material List
o
r Material Show Design Create
Takeoff = Report  Summary e
| 1) Prepare Material Takeoff ecks
Part Assembly List
&) List Assembly Subparts
. .5 Prepare Bolt List

By Prepare Assembly Bolt List

Prepare Washer List

Prepare Slopped Washer List

Gross Profile Material List

Plate For Built-U

Gross Profile Material List
A Functionality
Opens the Gross Profile Material List
dialog box.
» How to use :
Click the icon.

ProtaStructure® ProtaSteel’

Template
Fields
e Frofile Mame - |0
Mame o~ Profile Name:
N Beam Group Length
Select the required Length Cower Area
Cover Area Uniit ‘o' eight
parameters based e A
on preference Material
Marne
Part Mark
Azzembly Mark
User Defined 1
User Defined 2
4 | Dser Defined 3
& |Beam Group
Caption Length Unit mm
e ToSum Group By e

~| Insert Caption || Inzert Foater || Group || Inzert Group Foater

Separator Char |:| Select Unit
@Al

Famat Test i
O Selection

This report ignores any cuts or unions!

Export the Quantity Table
Generate the

Quantity Table o [Eecichepot] | (5o )

Close
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NC File Export

ProtaSteel can create the NC files for CNC machines to create the parts.

File Steel IntelliConnect Edit View Drawings & Reports Tools BIM Help
—_— NC Options =] X
Ilm.] ° h_»l D '!‘ M ark. Options
Import  Import from Export | Export | Export
DXF  ProtaStructure | IFC File | NC Files | to TEKLA Avvailable lbems Separator Selscted Items
BIM Links g;ttena\ l:l lI‘;‘ga'ltanal
Agzembly = Azzembly
Name L A
L'
. Go to the BIM NC file export S =
sslom ltem i =
. Select the items which you want to write on the Proview: -~ T ———
steel members. Fortteiht [ | /| Show NE Files
Start From Direction
: . . ®) Top Left Top Right @) Left To Right
. Set the text height and direction parameters. BotomLeR () Botiom Fight Top To Baltom
Machine Options
. Click “Run”.
Motch Radius [mm] I:I
Numbering must be completed before creating the NC files.
Cancel
Unsupported Situations:
. NC files cannot be created for pipe sections. The fish mount command can use for this issue.

. Plates must be Folded Plates.
The unsupported members will be added to the “not exported” list when files are exported.

Prepared NC files are located on the \Exports\NC\Plates or \Exports\NC\Profiles in the project folder.
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Closing Summary

Congratulations! You have completed your steel model & generated the engineering drawings in
ProtaSteel.

In this Quick Start Guide, we have imported the ProtaStructure model into ProtaSteel. We then inserted
ancillary steel members such as sag rods, adjusted members to their final positions, created some steel
connections & generated the engineering drawings. This guide will give you the necessary knowledge
to proceed to an actual project.

For more help and guidance, please refer to the ProtaSteel help reference accessible from the Help
menu.

Alternatively, you can attend our training courses to obtain more in-depth knowledge of software usage.
Please visit our website www.protasoftware.com for more information.
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Thank You

Thank you for choosing the ProtaStructure Suite product family.
Our top priority is to make your experience excellent with our software technology solutions.

Should you have any technical support requests or questions, please do not hesitate to contact us at all
times through globalsupport@protasoftware.com and asiasupport@protasoftware.com

Together with our responsive technical support team, our dedicated online support center is available
to help you get the most out of Prota’s technology solutions.

The Prota Team

ProtaStructure’
ProtaSteel’
ProtaDetails’
ProtaBIM’
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